
3 2 - b i t  v e r s i o n  f o r  
Windows® 10 / 8 / 7 / Vista
Copyright© 2004 M. Vannoye, licensed to ImageLevel

U s e r  M a n u a l

IMAGE MANAGEMENT SOFTWARE



2www.cadi.net US: 1-888-582-8115



Indications for Use

3

Indications for Use

Indications for Use

CADI is a dental imaging software for general dental and maxillo-facial diagnostic.  It controls capture, dis-
play, treatment, analysis and saving of digital images from x-ray units, intraoral or extraoral dental cam-
eras, digital cameras, and images acquired by digitizing film with a scanner, in order to enable a dentist to
diagnose the dental health of a patient.

CADI is a modular software, meaning that it offers dentistry professionals the choice to activate specific
modules, depending on the type of image sources they use. These modules are as follows:

Digital x-ray module:
This module features a 16-bit x-ray viewer and imaging tools used to enhance the image quality of x-rays
taken by sensors or phosphor plate systems.

Intraoral Camera Module:
CADI automatically enhances images captured by intraoral cameras and sorts them by tooth number.

Digital Camera Module:
This module allows importing digital camera images, and sorts them in specific order in a patient file.
Printouts are automatically sorted in AAO order, or any custom order.  This module also crops and prints
images.

Cosmetic and Whitening Module:
CADI simulates whitening results in minutes to help build an in-office program for patients.  It also provides
cosmetic makeover simulations using a library of natural smile images. 

Natural Smiles Library:
Smiles library that sorts images in a logical order, including images for a range of ethnic backgrounds.

Orthocephalometric Tracing (DFO) Module:
CADI DFO uses point location tools and a tutor window to help achieve cephalometric tracings.  It includes
most current and popular tracing analysis, and allows the user to create his/her own analysis.

CADI is a prescription use only product, intended to be used by dental professionals only.

www.cadi.net US: 1-888-582-8115
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Introduction - What is CADI?
CADI is an acronym for Clinical Applications in Dental Imaging.  CADI is a unique digital radiography and
dental imaging software that can help you get the most from your investment in digital imaging products.
By addressing various clinical applications you will benefit from:

-higher case acceptance through effective, proven communication using images.

-greater ease for you and your staff to integrate better presentation methods.

CADI makes it easier to integrate and use various digital imaging devices since by design, CADI was intend-
ed to interface with virtually any system on the market, allowing you to use hardware from multiple man-
ufacturers, all on one platform.  This in turn makes it easier for you and your staff to present cases, as well
as for the storage and retrieval of images.  Everything you need is in one place.

CADI will allow you to use your digital sensors and intra-oral cameras, along with your digital panoramic
machines and digital cameras.  All the while making it simple by allowing you to have automated custom
capture sequences, as well as the use of powerful imaging tools only ever seen in the medical field.

You and your staff will also benefit with time saving since you only need to “learn” one software to do all
your imaging, case presentations, reports and clinical digital exams.

www.cadi.net US: 1-888-582-8115
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How is CADI different from other software?

Unlike most softwares, CADI allows you to use many different “interfaces”.  CADI can accept virtually any:

-         Digital intra-oral sensor system;

-         Phosphor plate scanner;

-         Intra-oral camera;

-         Digital camera;

-         Digital Pan/Ceph unit;

-         CADI can be bridged with any practice management software.

Allowing you to combine these various medias, and the ability to combine various images on screen at one
time, allows you to present cases to patients in a more effective way.

CADI also allows you to organize your images in a more clinical friendly fashion.  We are all familiar with
the trusty film FMX mount made of plastic.  CADI can have this anatomical mount reproduced digitally, mak-
ing it easier to find the information you need at a glance.  Why stop there?  We have taken this idea fur-
ther allowing you to either use the default templates included or make your own images mounts.  Whether
you have just finished a cosmetic course at LVI or just like your images laid out in a particular fashion, the
possibilities are endless.

When it comes to imaging, you want to be certain you are able to bring the patients’ focus on what is impor-
tant.  The imaging tools in CADI have been developed with this in mind.  Whether you just want to change
the contrast of an image, or create a cosmetic simulation CADI, can help you do it all!

For a simple integration of digital multimedia tools for you and your practice, CADI is the only choice!

www.cadi.net US: 1-888-582-8115
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Description of the CADI Data and CADI
Interface
1.1   CADI Data Graphical User Interface (GUI)

1.1.1 CADI Data Main Window

The CADI Data Interface is the main window to access
your patients in CADI.

Since there are many points to explain, the main func-
tions are explained under the picture and the ones with
a red asterisk will be explained in more details in the fol-
lowing pages.

Please refer to the numbers on the picture for the appro-
priate information.

01 - Icon to access the application. (CADI)
02 - Icon to access Windows Calculator and/or MS Excel

in a separate window.
03 - Icon to exit the entire application.
04 - This is the “Patient Information” tab that will allow 

you to enter information about your patients.
05 - This is  the “Images” tab which will allow you to view 

images of patients. *
06 - This is the “Doctor” field.  This field has a drop down 

arrow to select the name. *
07 - The “New” button for creating a new patient. *
08 - The “Search” button to help you find a patient. *
09 - The navigation buttons help you navigate through your database of clients easily. *
10 - The second “Exit” button to exit the entire application.
11 - The “Add” button is for adding a picture of a patient to his file. *
12 - The “Delete”button is for deleting a picture of a patient from his file. *
13 - The “Alert” window is to display important information on a patient in a red flashing text. *
14 - The “Number” field contains the patient’s ID number. *
15 - The “Name” field is to enter your patient’s LAST name then FIRST name in the next field. *
16 - The big rectangle at the bottom-center is used for general comments and notes.  There are 3 levels of 

notes available.  There is also a tab called “Soc.Sec.” with its own field.
17 - The “Agenda” button brings a full screen window with an agenda.  See the appendix for explanations.

All the other fields are optional and left to each user’s discretion.

On the next pages, you will get a more detailed description on the items with a red asterisk.
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1.1.1 CADI Data Main Window (continued)

The “Images” tab, #05, allows you to see the patients images without having to open CADI.  This is espe-
cially practical when you are looking for an
example of X-ray or images.  It can also be
used for scrolling through your patients to see
the ones that have some pictures in them.

You can view pictures, change their name,
change directory for each picture, add key-
words or information to each picture, sort
pictures and/or delete them.

Double-clicking a picture with the left mouse button will open CADI and show you that picture in the first
viewport.  You can always navigate through the patients by using the left and right arrow icons on the right
side of the images window.  These are the same buttons used for the “Patient information” tab.

The “Doctor” field, #06, is very practical if there is more than one dentist in the clinic.
This field allows you to assign a specific doctor to each individual patients.  You will use
this field even if you have only one doctor in the clinic.  It is important to fill this field
because its content will be written on every image and report you create for each
patients.  More details in the section about preferences.

The “New” button, #07, is one of the most important on the page.  When you click on it,
you will get to a new patient number automatically, and you will have to enter a minimum
of information about your patient.  The mandatory fields are the patient number, the last
and first name.  Besides these 3 fields, you don’t have to enter any other information, it
is left to each user’s discretion.

The “Search” button, #08, requires a more detailed explanation.  When you click on this
button, a new window appears with a partial list of names, and some fields at the bottom.
This is where you will go to find patients by many different means.

The search screen looks like the picture on the left (picture shorter than
original for space purpose).  There are many ways of searching with the
fields at the bottom of this window called “Search for” which contains
a list of searchable fields.

The drop down list allows you to search by many different criteria such
as name, number, city, birthday, and more.  When using the name field,
always remember that the last name comes first.

HINT: When searching by name, you could end up with many people
with the same last name, in such a case you would add the first name.
To do so, write the last name then put a coma “,” and type the first few
letters of the first name and it will appear in the list.  Don’t leave any
blank spaces between the coma and the first name.  The search in CADI
is “intelligent”, meaning that it will display results of the search as-you-
type the characters.  This means that you don’t have to type the whole
name, just the few first characters.

www.cadi.net US: 1-888-582-8115
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1.1.1 CADI Data Main Window (continued)

The navigation buttons, #09, are used to manage your patients’ list.  The left and right
arrow buttons will allow you to go back and forth in your patients list.  The plus (+) sign
button allows you to add a new patient.  The minus (-) sign button allows you to delete a
patient.  The button with a triangle (    ) is the one used to modify an existing patient’s

information.  The check mark button (ü) and the ( X ) button only appears when you are in the modifica-
tion mode, and are respectively for saving the information or deleting the patient completely.  The ( X )
(delete) button should be used with care.  The deletion of a patient is an unrecoverable action and thus
will oblige you to re-create the deleted patient.

The “Add” and “Delete” buttons, #11 and #12, are to add or delete a picture of your patient
to his file to identify him/her more easily.  This is an optional function and will not influence
the way CADI works.

To add a picture to the current patient, you must first be in the “Edit”
mode.

To do so click on the button with a triangle (    ) in the navigational but-
tons.  The save and delete buttons will become activated.

Now click on the “Add” button.  This will bring up a window like the one
on the left and you will be able to choose the picture you want to insert in
the patient’s file.  You choose the picture by double clicking on it with the
left mouse button.  The picture will automatically be inserted in the frame
“Patient Image”.

HINT: To have a better quality image of your patient, be sure that when you take his picture with your dig-
ital camera and save it to your computer, choose a JPG (JPeg) or BMP (Bitmap) format.  This will allow you
to really see the picture with the right format and colors.  You can add other types of pictures, but you will
get a message from CADI Data and the picture might be unclear or you might see only parts of it.

Back on the CADI Data screen, do not forget to click on the button with the check mark, using
your left mouse button, in order to save your changes.  If you forget to save, and move to anoth-
er patient or exit the application, the picture you have chosen for this patient will still be saved
for the next time you access his/her file.

To delete a patient’s picture from a patient file, you must first be in the “Edit” mode.  Then sim-
ply click on the “Delete” button and click on the save button in the navigator.  Many clinics choose
to have patients information without their picture, it is not a mandatory part of the process.

For more information on getting a picture to be the right size or format, consult your local tech-
nician or graphic artist.

www.cadi.net US: 1-888-582-8115
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1.1.1 CADI Data Main Window (continued)

The “Alert” Window, #13, is very practical for taking important notes for a patient.  Once
saved, these notes will be in RED text and will also be blinking as a reminder.

To add an alert to the current patient, you must first be in the “Edit” mode.  Then click in
the window and start typing.  The text will already appear in red and start blinking from
black to red.

Once you have typed in your alert, click on the button with the check mark, using your left
mouse button, in order to save your changes.

To delete an alert, be in the “Edit” mode, and simply delete the text from the window and
save your changes.

The “Number” field, #14, is a very important field in CADI Data.  This field will assign the ID
to each patient.  This is a process done automatically by CADI Data.  In a new environment,
there are no configuration or settings to modify.

If you want to attribute your patients’ ID according to the order you choose, you will have to enter the
number that you want manually each time you create a new patient.  This method will force you to keep
a list of the patient numbers in order to know what number to enter next in that field when creating a new
patient.

When creating a new patient and inserting the number yourself, you have to enter the number before
saving the information.  You simply erase what is in the “Number” field, after you have clicked on the
“New” button, and write down the number that you choose before entering any other information

The “Name” field, #15, the first  rectangle following the word
“Name” is for the LAST NAME of the patient.  The second rectan-
gle under the name is for the FIRST NAME of the patient.  If you
enter both names in the first rectangle, you may not be able to
locate that patient in the future.

The big rectangle on the screen, #16, is for general notes and comments you
would like to attach to the patient’s file.  This has no impact on what is shown
in the application besides seeing it when accessing the patient’s file in CADI
Data.  There are 3 levels of notes, each is independent from the other.  You
can change the name of the tabs in the “Options”, “Setup” part of CADI Data,
see “Various” tab later on.  You can use this information when using the
“REPORTER” module.  If you have notes that you usually put in the patients’
reports, you can enter them here and then insert this field in your report.  See
“REPORTER” section.

The “Soc.Sec.” tab has its own field and is not displayed by default for secu-
rity reasons.  You can use these field and they will be accessible when using
the module “REPORTER”.  Like in all the modules of CADI, you do not need
to enter data in every fields, only the one you will be using.

www.cadi.net US: 1-888-582-8115
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1.1.2 CADI Data Menu Bar

The first item is “File”.  You can either use “Launch imaging software Ctrl+I” or “Exit”.

The “Patient” menu offers you to “Search   F2”, “New  Ctrl+Ins”, “Edit  Ctrl+Enter”, “Post  F8”, “Cancel
Shift+Esc”, “Delete  Ctrl+Del”, “Next  Ctrl+Right” and “Previous  Ctrl+Left”.  These choices do the same
action as pushing any corresponding button like “New”, “Search” and the navigation buttons located under
the search button.  You can use either and the action will be the same, it is only a question of preferences.

The choice “Reports” offers you seven (7) ready to use reports.  Cadi will create a file with the
criteria you ask and display it in an orderly fashion.  Once built, you can save the report to an
Excel spreadsheet for future usage.  There is the option “List of all patients” that will create a
list of all the patients in the database.  This is usefull to review your patients in order to clean
up the database once in a while, removing or archiving the patients that are deceased or moved.

In “Options” you will find 2 items, “Preferences” and “Import”.  The “Import” item will be grayed out
because it is for use only with a certified CADI technician.  Within the “Preferences” menu you will have
to make certain configurations.  Click on “Preferences” and get to the next image.

The window is divided in different tabs.  First let’s review the “Practice Info” tab.

The rectangle under the header “Practice” is to enter the actual
name of your practice.  This information will appear on your print-
outs, so it is important to fill it.  If there is only one doctor in the
clinic, simply put his/her name and click on the check (ü) button.

Under the header “Doctors”, you can type each doctor’s name for
the same clinic.  Once a name is typed, click on the check (ü) but-
ton at the bottom to enter it in the list.  To add a doctor simply
click on the “+” button.  Repeat this for each name.  You can

delete an invalid entry by clicking on it and clicking on the “-”
button.

Those buttons at the bottom will appear in all the other tabs
which allows you to insert pre-typed input.  Their function is the
same in all the tabs where available.

www.cadi.net US: 1-888-582-8115
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1.1.2 CADI Data Menu Bar (continued)

These arrows are used to navigate from the first to the last item in the list.  The arrows that have bars
at their tip are to navigate directly to the first or the last item directly. 

The (+) plus sign is used to add more items in the chosen area.  The (-) minus sign is used to delete an
item from the chosen area.

The triangle button is the most used button.  Click on it to modify any information on the screen.  If not
pressed, you will get an error message when trying to change information.

The check (ü) button is used to save information or changes.  The (X) button is used to cancel any changes
made to the screen.

The curved arrow button is for refreshing the screen.  After adding information and saving it, pressing this
button will show the screen as it is now configured.

www.cadi.net US: 1-888-582-8115
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1.1.2 CADI Data Menu Bar (continued)

The “Forwarding1” tab is used to enter the names of specialists
you want to forward some letters and/or images of patients.  These
fields are used on the CADI Data interface and are located at the
bottom left of the screen.  They are independent for each patient
and are optional.  The “Forwarding1” tab contains the field for the
“Dentists” and “Doctors” names.

The “Forwarding2” tab is used to enter the names of specialists you
want to forward some letters and/or images of patients.  These
fields are used on the CADI Data interface and are located at the
bottom left of the screen.  They are independent for each patient
and are optional.  The “Forwarding2” tab contains the field for the
“Orthodontists” and “Perio-Stomato” names.

The “Referring” tab is used to enter the names of special-
ists that refered some patients to you.  This field is used on
the CADI Data interface and is located at the bottom left of
the screen.  It is independent for each patient and is option-
al.

The tab “Subject” is used to enter different
subjects that your practice encounters the
most, so that you can select it on each individ-
ual patient according to the kind of care he/she
needs.  This field is used on the CADI Data
interface and is located at the middle top part
of the screen.  It is independent for each
patient and optional.

The “External” tab links external application to CADI Data.  The
information you might need is in the “Patient Directory” field.    It
indicates where your patients database is located.

To link an application, simply type a name in the “Name” field,
browse to find the application using the three dot icon (...), and then
click on the “Add” button.  This will create an entry in the “Link
with:” box.

After exiting this option, you will see a new icon on your CADI Data
toolbar.  It is the one for the link you’ve just created.

To delete a created link, go back to the “External” tab, click on the
link in the box and click on “Delete”. The link will disappear.

At the bottom right of this screen, you can choose to display or hide the linked icon to Windows Calculator
and to MS Excel application.
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1.1.2 CADI Data Menu Bar (continued)

The “External 2” tab links a PMS server to CADI.  The PMS icon
will only be available when the DLL is found in CADI directory.
The same applies to eID.  Consult your representative for more
information.

The “Agenda” tab is where you can configure CADI DATA Agenda to
suit you needs.

The usage of this is covered in the appendixes.  If you are using a
practice management (ex: PowerPractice, Abeldent, Dentrix, etc.),
you do not need to use the Agenda or CADI DATA.

The “Various” tab is used to rename the “Info” tabs in CADI Data to
a more appropriate name.  There are three (3) tabs and they are all
independent from each other.  You can name them separately.

In the “Search” section, if you have a very large database you can
put a check mark and it will generate names only related to the first
characters you type.

The “Standard style” area is new.  It allows you to change the color
of the buttons in CADI.  The default style is AURIC.

It is also in this tab that you can make the Image tab of CADI DATA
bigger.  In the section “Magnification factor” you can select the
size.  Under this option is a very important one; “Recreate stamps
for new size”.  You need to check this option in order for the stamps
to be viewable on the Image tab window.

The “Registration” tab shows information about your CADI
Data version and code.  There is nothing to enter or modify
in this tab.  It is mainly an informative tab.

www.cadi.net US: 1-888-582-8115
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1.1.2 CADI Data Menu Bar (continued)

The “Backups” tab allows you to specify if you want a backup of the data-
base done automatically and to what frequency.  You can also specify the
number of patients to scan for the backup.

This function allows you to rebuild the database of the client’s name when
it gets corrupted for whatever reason.  This will only rebuild the database
part, it will NOT backup or restore ANY images.  Once again this is for the
client database, the information of the patients ONLY.

The “Language” menu offers many languages in which to set the CADI Data interface.  The lan-
guage chosen in this menu option will not influence the language in CADI.  Each application must
be set to the desired language.  See the section about setting up the language in CADI.

The “Help” menu contains only the “About” option.  This option will show you the version of CADI
Data in a separate window.

This concludes the section about CADI Data Interface.  You should familiarize yourself with the different
functions of CADI Data in order to use it to its full potential.
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1.2   CADI Graphical User Interface (GUI)

1.2.1 CADI Main Window

CADI’s Main Window is called Desktop and consists of Status mounts, Status boxes, viewports, buttons and
tools, and the Desktop Panels.

Desktops are complete viewing screens that have been set up to display imaging information in a specific
manner.  Desktops can be changed to present different views of images.

Viewports are areas on the screen where images can
be viewed and diagnosed.

Status mounts are mounts built with Status boxes in a
predetermined manner and sequence, and each mount
stores images by their position in the mouth.  This
facilitates image storage and retrieval.  They have dif-
ferent names for different exams and you can create
your own.

Status boxes are thumbnail (small) images or your real
x-rays and pictures taken from the Image Library, (see
Image Library versus Status Mounts chapter), placed in the proper
order according to the selected mount.

Buttons and Tools are icons that can be used to
enhance images and activate the various features of
CADI.  These will be described in the Icons Description chap-
ter of this manual.

Desktop Panels are panels that can be added to the
desktop when creating a new one or modifying an existing one.  These are already configured by default
for you and should not be modified.  If you decide to modify an existing desktop, name it differently.  This
will be explained in a later section of the manual, please refer to the index.

Remember that everything in CADI is already configured for you.  When changing something, always give it
a personalized name so default settings of the CADI application are not modified.

The creation and/or modification or Desktops and/or Status Mounts is not covered by CADI technical sup-
port specialists except under certain conditions.  Ask your CADI representative or see our Web site for
details.
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1.2.2 CADI Menu Bar

The CADI interface contains many different parts.  We will start by exploring the menu
options of the application.

The “File” menu contains many choices.  Most of these choices are actually accessible
from the icon pad at the bottom left of the desktop.

“Show patients list, recently accessed for this workstation” will show you a list in a sep-
arate window with the names of the patients accessed on this station during the current
month.

“Open archive” will be available only if you have created archives.

The “Quit” button at the bottom will minimize CADI and bring CADI Data to the front of
Windows desktop.  This “Quit” button will not close the actual application, it will only
minimize it at the bottom of the screen.

In order to get out of CADI completely, you must use one of the available buttons on the
CADI Data interface.  Please refer to that section for information.

The “Edit” menu contains many edition tools for the picture actually in a viewport.  If some options are
grayed out, you have no images loaded in the selected viewport.  Here is a description of each choices in
this menu:

• “Filter Undo/Filter Redo”: To undo or redo a filter on the active image;

• “Copy to clipboard”: This option is like the copy function of Windows;

• “Optimize” : Applies the default optimize filter. This function can be configured in a dif-
ferent section of the menu.  This is only to apply on the image in the selected viewport.

• “Paste from clipboard”: This option is like the paste function of Windows;

• “Clear Viewport” : Clear all the viewports of their content.

• “Delete image from disk” : Permanently deletes the image in the viewport selected.  Use
this option carefully.

• “Resample Image” : Redraws the image that you see on screen.

• “Convert current image to grayscale” : Converts the image in  the active viewport to a grayscale format.

• “Paint Calibration Ruler On Image” : Inserts a little scale on the top right side of an x-ray.  Used only for
calibration and measurements.

These options are accessible from most modules of CADI, please see the main index for the options avail-
able in the “Edit” menu of that module.

Some modules have very different options that will be covered under their own sections.  Since CADI is a
complex and fully customizable application, we must proceed in order so the user understands the  princi-
ple behind this complete digital imaging solution.
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1.2.2 CADI Menu Bar (continued)

The “Display” menu item contains four (4) major sections: “Desktop Panels”, “ViewPort”, “Set current
viewport to”, and “Filter selection”.  The item “Negatoscope” is to clear the screen of all display and
show you a white background to look at film x-rays.  You exit this function by pressing “ESC” key on the
keyboard.

In the “Desktop Panels” section, you will see all of the options that can be added
to the CADI desktops.  The ones with check marks are already part of the visible
desktop.  All of these options are described in the “Icon Description” section of
this manual.

Notice at the bottom of this menu that “Lock desktop” is checked.  This is to
avoid making undesired change to the current desktop.  When changes to the
desktop are required, click on this choice with the left mouse button in order to
remove the check mark.  (Making changes to the desktop is not explained in this sec-
tion.  Please refer to the index for further explanation on how to modify the desktop.)

By clicking on “Load desktop”, you will obtain another window with choices.

These are the pre-configured desktop created to fulfill most needs in dental
imaging.  You have to choose a desktop that can fit your screen resolution in
order to see all the menus and icons in CADI. (See your Windows Display

Properties for details.)

The “ENDO” desktops are set especially for endodontists and thus should be used
only by them.  They have been created according to their daily tasks.

The “800x600” desktop is created for administrative purposes for people who don’t
need to access the imaging modules.

You can create additional desktop, use the “Save desktop as ...” and/or “Save desk-
top” choices to record the changes when modifying a desktop content or display.
They will be covered in a later section.

Reminder: If you intend to make changes to the desktop, be sure to remove the
check mark on the item “Lock desktop”, otherwise you will not be able to make any
changes.  We also recommend to lock the desktop again once your changes are saved.

In the “ViewPort” section of the menu you will find five (5) viewports numbered from 1 to
5.  The number of viewport with a check mark next to it should correspond to the number
of viewports on your actual desktop.

The “Fixed” option means that the viewport will not move, it will stay in its current posi-
tion.

You can add or remove viewports; see the relevant section of this manual.
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1.2.2 CADI Menu Bar (continued)

In the “Set current viewport to” section, accessible only when you have an image in the viewport, you will
find settings for the actual viewport.

The item “One Image Pixel = One Screen Pixel” will show you the image in the
viewport with no resizing, as it is when viewed at 100%.

The item “Fit” (default) is preferred since it will resize the picture to fit in the
viewport completely.

The item “Fit Sides” will make the image fit the screen on the left and right side.
This might create a scroll bar for vertical scrolling.

The “Normal Quality (Fast)” item loads the images faster on-screen, but at the
cost of some quality.

The “High Quality (Slow)” (Default) item shows the images in a higher quality, but
takes more time to generate.  This is not true if you have a high end system because you will not see the
difference in the loading time.  This is the preferred choice.

The “Calibrate” item loads the calibration window, also available through the icon pad.

The “Draw grid” and “Draw ruler/scale” item will display a grid/ruler/scale on any COLOR images loaded
in a viewport.  The options controlling the grid are available in the “Display Settings - Viewport Settings”
of the “General” settings from the “Options - Setup (or F10)” menu item.

The option “Show filter script” will display the filter/script window if an image is in the viewport.

When you click on “Filter selection”, a new window appears offering you a choice of filters for the
image actualy on screen.  The effect of each filter is shown directly so that you can compare the dif-
ferent filter effects.  The name of each filter is written on top of each image.

Take note that the module and device used to take
the image is indicated on top of the window.

You can use the arrow at the end of the field “Go
to filter” to choose which one you want to see of
simply navigate with the arrow icons on the left
and right.

You can zoom the filtered images by clicking on the
button “CTRL-G” at top right.

You can choose how many filters are displayed per
page, at the bottom of the window (Max. 10).

Once you’ve found the desired filter, you can
either “Set as default for devices” or “Apply on
this image” by clicking the appropriate button.
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1.2.2 CADI Menu Bar (continued)

If you click on “Show filter editor (CTRL-F)”, a window like this one will open to
show you the content of the selected filter.

You can experiment with the filter by moving the order of the options or by uncheck-
ing certain options.  You can edit the filter and create a new one.

The icons on the left are for the following functions:
(Top to bottom)

- Move selected line up in the script
- Move selected line down in the script
- Remove selected line from the script
- Disable all filter script lines
- Enable all filter script lines

- Load original script
- Show visual filter builder
- Create new filter
- Save current filter

The tab “Raw Mih Data” shows the filters code in text form like it appears in the files.  This is only a ref-
erence for technicians.

The “Options” menu items offers many different options.  The following pages will review these options.

The “X-Ray Acquisition” option has a second window that pops up and allows you to select the
acquiring device for the X-Rays.  This part will be covered in the initial configuration of your system
and has some different options for each sensor.

The “Video Still Capture” option also has a second window that pops up.  In this one, you choose
the method used by your video capture card to capture images in the PC.  With most recent systems
the choice is “WDM Still Cap”.  For older video capture cards, you will have to choose “VFW Still
Cap”.  This will also be covered in a later section.

The “Calibration Table” option will bring a new window like this one.  These are the
measurements for the whole image as opposed to the other calibration that will be used
for more accuracy between the sensor and the screen.  See “Annotations and Measurements” in
the Icons Description chapter.

In this window, you can “Add”, “Delete”, “Save” and “Exit”.  Before using any of these
functions, be sure to have taken note or the original settings.  A bad setting will distort
the images on screen.  Be careful with that function and ask for help in case of doubt.
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1.2.2 CADI Menu Bar (continued)

The “Macro’s” option of the “Options” menu brings up this window.  By default,
the only macro created is the one calling the help file of CADI.

You can set additional macros as you need them.  You can use all of the functions
key of the keyboard, “F2” to “F12” on most of the keyboard, to record new
macros.

There are five (5) buttons in this interface: “Add”, “Edit”, “Delete”, “Record”
(the button with a red dot), and “Exit”.

You will learn how to use this function later on in the manual.  Please refer to
the Index.

The “Customize Button Toolbar” option of the “Options” menu brings up this window.  By default, all the
icons for your chosen desktop will be shown.  The icons with a red diagonal line across them are icons not
shown in your icon pad at the bottom left of the CADI screen.

To add an icon to your CADI icon pad, use the right mouse button and click on the desired
icon that has a red diagonal line across it and you will see the red line disappear.  Click
on the “Save” button with the left mouse button and the icon will automatically appear
in CADIs’ icon pad.  To remove an icon from the pad, choose it and click it using the right
mouse button, a red line appears, click on “Save”, the icon disappears from the icon pad.
The choice “Save to all desktops” will reproduce the chosen icons and their order for the
five (5) available desktops.  The “Add spacer” button will add an empty icon between
two (2) displayed icons.  It can serve to separate the modules from the tools as an exam-
ple.

To get back to the default icon for your desktop, click on “Defaults” then on “Save” and
the icon pad will be back to its original state.  You can exit this  function by clicking on
the “Exit” button with the left mouse button.

The “Setup” option of the “Options” menu brings up a
window like this one.

Since this window is a major component of the configura-
tion, we will not review the content at this time.  This is
where all the settings for your digital sensor, intra-oral
camera, scanner, microscope, digital camera and printing
are stored.

We will review this window and its content in more details
in another section of this manual.  Let’s continue explor-
ing the CADI interface to review all the choices and
screens available.
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1.2.2 CADI Menu Bar (continued)

The “Language” menu offers many different languages to choose from.  This language menu will influ-
ence the language in every modules of CADI.  It will not influence the language choice in CADI Data.  Both
languages must be set separately.

When you change the language in CADI, the CADI interface will be reloaded to immediately apply your
choice.  When reloading the interface in the new language of your choice, CADI will return to the same
patient with the same pictures loaded in the viewports if there were any.

You cannot change the language once in a CADI module.  The choice must be done prior to doing any
operation.  This is generally a one time configuration.  Once you’ve chosen the language for CADI, it will
load with the same one each time.

The “Help” menu offers six (6) choices: “Help”, “About”, “Visit our website”, “Online support”, “Check
for updates” and “Registration”.

The “Help” option will bring an on screen help file containing some but not all the information about cer-
tain functions.  There are more information in the manual you are reading.

The “About” option will bring a window with information about your CADI version.  This is different than
the one displayed in CADI Data.

The “Visit our website” option will open an internet browser and bring you to the www.cadi.net website.

The “Online support” option will open your default internet browser and bring you to the CADI SUPPORT
website directly. (http://www.support.cadi.net)

The “Check for updates” option will open an internet browser and bring you to the ImageLevel website and
allow you to download updates from their site directly to the computer.  This option is not effective yet.

The “Registration” option is used exclusively with/by a support technician if there is a need to modify your
CADI USB Key.
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Icons Description
2.1   Description of the Icons in CADI

2.1.1 Icons of CADI

X-Ray Acquisition FMX (series)
This icon brings up the Full Mouth x-ray capture screen.  See the x-ray section for usage.

X-Ray Acquisition
This icon brings up the single x-ray capture screen (default mode for endodontists).  See the x-ray section
for usage.

Video Still Capture
This icon activates the connected video capture device: Intra-Oral Camera, Microscope, etc.  See the Video
Capture section for usage.

Import Picture Directory
This icon accesses the import picture directory screen.  This is used for importing images from a digital
camera or other sources. See chapter on Picture Directory Import & Export for usage.

Export Picture Directory
This icon accesses the export picture directory screen.  This is used for exporting images to different loca-
tions or email. See chapter on Picture Directory Import & Export for usage.

TWAIN Image Acquire
This icon initiates scanning of x-rays and images from a TWAIN compliant scanner.  See the TWAIN Scanner
section for usage.

Desktop Selection
This icon is used to switch between desktops.

To activate, press and hold the left mouse button over the icon for one (1) second, or click on the icon with
the right mouse button, then select the desired desktop with the left mouse button, from the list that
appears.

29www.cadi.net US: 1-888-582-8115



C h a p t e r  2 : Icon Description

30

2.1.1 Icons of CADI (continued)

Save Image
This function allows storage of any activated image, after modification.  All modifications are stored with
the image which will appear in the viewport in the future instead of the original image.

In “Options”, “Setup”, “General”, it is possible to activate an option to save as a new image.  This  option
is not completely active in CADI as the new image will not currently be stored in the status box but in the
image library, so remember to reload the image when using this function.

Note that even when writing over original image, the original image still exists and can be brought back by
using the “Reload” icon.  When using the reload icon you will loose all modifications made to that image.

Reload Original Image
This icon reloads the original unmodified image from the image library or the status.  All the post process-
ing done on the active image will be reset. (brightness, contrast, pseudo-colors...)

If you have previously saved your image as a modified image (Yellow Tab), the Yellow Tab will disappear as
well as the modified image and all modifications will be lost.

Delete Image
Use this icon to send images to the recycle bin.  Before deletion, the software will ask you to confirm the
deletion.

Optimize
Choose this option to apply a series of actions to an active image.  To activate, press and hold the left
mouse button over the icon for 1 second, or click on the icon with the right mouse button, then select the
desired optimization.

There are over 20 filters available in CADI and you have the possibility to create more.  There are new ways
to use the filtering in CADI and there is a chapter on these new ways.

By default, CADI images are optimized upon capture and it is not necessary to use this function.

It is possible to press the optimize button more than one time to continue to apply the same actions to an
image.

Optimize can be customized, but only by advanced user and is not documented here.
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2.1.1 Icons of CADI (continued)

Annotations and Measurements
This function allows you to add Arrows, Ellipse, Text and Notes in different colors and sizes on any
activated image. (NOTE: For further information on the “Implants” tab, refer to the index of this manual.)

This function will never affect the original image.  It’s like a transparent layer that you can show or hide
on the screen.  You can also print the annotations together with that image.

To use these options, load an image in a viewport by double-clicking on the desired image from the status
mount or image library.

• Press the “Annotations and Measurements” icon;
• Click on the tab “Annotations”;
• Press “Pointer” to draw an arrow;
• Press “Freehand” to draw freely with the mouse;
• Press “Ellipse” to add a circle or an ellipse on the image;
• Press “Text” to add some text on the image;
• Press “Note” to add some notes (like a Post-It).

To delete an annotation, press “Select” with the left mouse button, then select the desired
annotation with the left mouse button and press the “Delete” key on your keyboard.  To delete
all annotations, click on the button “Delete All”.

You can change the color of the annotation by pressing “Select” with the left mouse button,
then select the desired annotation with the left mouse button and then change the color to
“Red”, “Blue” or “Green” (or use the color chart to choose a color).

You can change the size of the annotation by using the left mouse button and press on “Select”.  Then click
the desired annotation with the left mouse button, and change the size with the left and right arrows but-
ton (next to the “Size”), using the left mouse button.

To save your current annotations, simply depress the “Annotations and Measurements” icon.

The second part of the Annotations and Measurements function is the measurements.

The first step, only if required, is to calibrate the image.  By clicking on the “Calibrate” tab
with the left mouse button, it will bring you a window like the one shown here.

The “Calibrate” tab is used if CADI cannot determine the scale of the original image (such as
digital photos, unknown x-ray imports, intra-oral camera images, etc.).  In such a case, enter
any known measure in one of the choices under the “Select the known calibration” heading.

It may also be used if there is a considerable angle between the x-ray beam and the digital
sensor.  In this case, draw a line from the starting and ending points of a known distance (such
as from endo stopper to the tip of the endo file) and enter the line length in the appropriate
box.

All further measurements on this image will use this calibration value.
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2.1.1 Icons of CADI (continued)

Annotations and Measurements (continued)

In the “Measure” tab, you have many ways to calculate, lets review the most common ones.

To measure a simple line, click on “Line” using the left mouse button, click at the starting point
of the image and then click again at the ending point of the image.  The measure will write
itself on the screen.

To measure a curved line (polyline), select “Polyline” with the left mouse button, then still with
the left mouse button, click at the starting point and click at any curves you encounter in the
line.  At the end of the line, double-click the left mouse button to save.

(Calibration issues are not part of the technical support from CADI since they are PER USER configuration
and cannot be done over the phone. For a detailed example of calibration, see the index of this manual.)

Classic Print

This function allows you to select the printing mode between 1, 2, 3 or 6 images per page.  To use it, click
on the “Print Classic” icon, a window like the following will appear.

Select the printing mode in the “Pics/Page” section on bottom right.

The “Image Library” window contains all the available images for this patient.  A scroll bar allows you to
move through the image gallery.  To select an image, double-click on it and it will appear in the “Output”
window, in the first available rectangle.

The “Output” window contains the images to be printed:

“Clear” allows you to delete all images from the
Output  window.
“Delete” allows you to delete a previously selected
image from the Output window.

The images are printed together with the patient’s
name, birthday, the doctor’s name and the saved
comments.

You can add additional comments in the “Comment”
section (available only on 1, 2 and 3 pics/Page).
The “Annotations” and “Borders” printing options
allows you to print the annotations and/or the bor-
ders with the selected images.

To start printing, click on the button “Print” using
the left mouse button.

To modify printer settings, click on “Setup Printer”
using the left mouse button.

To leave this function, click on “Exit” using the left
mouse button.
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2.1.1 Icons of CADI (continued)

Status Print

This option is used to view/print a complete Status Mount.  It will quickly crop/zoom images into
predetermined boxes and position/center images for printing.

Use the left mouse button to reposition or resize the image frame.
(Desktop must be unlocked.)

With the mouse wheel, you can increase/decrease the size of the
image inside the frame.

Use the right mouse button to reposition the zoomed image within
the frame.

The results can be saved, printed and/or exported as desired.

(Image for demonstration purpose only.  Creation of printouts is not
covered by technical support.)

Region of Interest (ROI)

Use this feature to select a region within an active image.  This region will then be blown up on screen so
you can work with it.

To proceed, select the “Region Of Interest Rectangle” icon with the left mouse button. (If the selection is
not rectangular, then change it by clicking the bottom right of the icon and selecting “Region Of Interest
FreeHand”.)  Now click and hold down the left mouse button in one of the corner of the region you want
to select, draw a square around the region you want to work on (multiple click for free hand).  Once the
square contains the region you want, release the left mouse button.

Two (2) choices are available at this point.  Display the chosen region in a new viewport, or have it appear
in the same viewport as the actual image.

To have the chosen region in a new viewport, click on an empty viewport with the left mouse button and
depress the “Region Of Interest Rectangle” icon to see the new created image.  You can now click “Save
Image” to save this Region Of Interest as a new independent image.

To have the chosen region in the same viewport as the actual image, simply depress the “Region Of Interest
Rectangle” icon and the actual image will be replaced by the newly selected region.

To keep an image of the selected region, click on the “Save Image” icon with the left mouse button and
this will replace the actual image by the newly modified image.  To get the original image back, click on
the “Reload” icon with the left mouse button.  Be aware that by clicking on the icon “Reload”, you lose
the Region Of Interest created and will have to re-create it if you need it again.
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2.1.1 Icons of CADI (continued)

Zoom Window

The Zoom window allows you to magnify the image with great precision.  This is possible thanks to the supe-
rior zoom ability and the 5 special filters. (The zoom window can be sized bigger or smaller.)

Each movement of the cursor on the loaded image will be displayed in
“Real time” in the zoom window.

Zoom in and out simply by using the mouse wheel (if applicable).  In the
zoom window, the cursor is represented by a cross.

As long as the pixels in the zoom window represent more than one (1)
pixel of the captured image, you will see the cross hairlines that repre-
sents the mouse cursor.

At the bottom of the zoom window, 5 different buttons are displayed.
These are filters for the zoom window that allows you to tweak the sec-
tion of image displayed in the zoom window.

1 None (Do nothing)
2 Invert
3 HistoEqualize
4 Emboss_NE
5 Gamma correction

Switch from one filter to another at any time simply by clicking it with the left mouse button.  The
“Emboss_NE” and “Gamma correction” filters can be adjusted with the up and down arrow keys on the key-
board.

Histogram

This function allows you to display the histogram of the image.  A histogram represents the distribution of
the pixels in an image.

Status Mount

This icon is activated by default in almost all of the preconfigured desktop available with CADI.  It allows
you to view the images in a Status Mount view.  This option should ALWAYS be activated.

Rotate

This function rotates the active image 90 degrees clockwise (right).  Each additional click will rotate  anoth-
er 90 degrees clockwise.  As an example, for an image that is upside-down, you have to click twice on the
“Rotate” icon to get the image back to the right orientation.

Horizontal Mirror

This function mirrors the active image horizontally.
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2.1.1 Icons of CADI (continued)

Vertical Mirror

This function mirrors the active image vertically.

Invert

This function changes the display of an image from positive to negative or vice-versa.  If you use this func-
tion on a X-ray image, with a pseudo color filter applied, the image will be recalculated into complemen-
tary colors.  Clicking a second time on this icon returns the image to its original settings.  This       func-
tion can also be used to invert color images or negatives.

Auto Contrast

This function automatically defines the optimal contrast and brightness settings of the active image.  The
auto contrast can be activated before or after the acquisition (see SetUp section).  the auto contrast func-
tion can only be activated once.  This function, when activated, automatically eliminates all previous
changes made manually. Auto contrast settings will be saved if the image is saved or re-saved after acti-
vation.

Noise Reduction

This function reduces the noise from the selected image.  This function can be repeated as much as desired
on any image.

Cosmetic Module

This icon launches the Cosmetic module (only if available).

DFO Module (Dento Facial Orthopedics)

This icon launches the DFO module (only if available).

Sharpen

This function sharpens the active image.

WDM Streaming Video

This icon launches the WDM Streaming Video module to capture live movies in CADI.

www.cadi.net US: 1-888-582-8115



C h a p t e r  2 : Icon Description

36

2.1.1 Icons of CADI (continued)

Filters
This function opens a small window with different filters that can be applied to a picture.  These filters
are reviewed with the picture below.

“Histogram Contrast”: This function does not affect the color balance of the image. This
method enhances the whole image but still maintains a color cast in the highlights.  Its best
use is on an image that is too dark.

“Histogram Equalize”: The Equalize command puts more contrast to an image with a
grayscale that is too wide. When you choose this command, the software finds the brightest
and darkest values in the image and averages all the brightness values so that the darkest
value represents black (or as close to it as possible) and the brightest value represents white.
It then attempts to equalize the brightness—that is, to distribute the intermediate pixel val-
ues evenly throughout the grayscale.  You might use this command when a scanned image
appears darker than the original to balance the values to produce a lighter image. Using the
Equalize command together with the Histogram command allows “before-and-after” bright-
ness comparisons.

“Stretch Intensity”: The Stretch Intensity command automatically defines the lightest and
darkest pixels in each channel as white and black, then redistribute the intermediate pixel
values proportionately.  This function gives good results when a simple contrast adjustment is
needed to an image with an average distribution of pixel values.

“Gamma Correction”: Gamma Correction is the process of adjusting your monitor and the
software color conversion settings, to compensate for factors that affect both the on-screen
image and its conversion to printed output.  It will allow you to see the image with much more
brightness.

“Sharpen”: Sharpen filters focus blurry images by increasing the contrast of adjacent pixels. 

“Shadow”: This filter produce a emboss-like image.

“Spatial Filter”: Press the right mouse button to select which spatial filter you want to use (advanced
users), then click on the left mouse button on your selection to activate it.  The Spatial Filter simulates an
emboss process on the image according to the chosen method.

“Despeckle”:  This function removes some unwanted dust and hairlines on an image.  Although very dis-
creet as a function, if too much despeckle is applied to an image, it will loose some of its sharpness.

“Median”, “Average”, “Gaussian Blur”:  These functions remove noise from an image.  Noise in an image
is simply pixels with randomly distributed levels.  “Gaussian Blur” is the best method although it takes more
time to apply.

“Unsharp Mask”:  “Unsharp Mask”, or unsharp masking, is used to sharpen edges in an image.  Unsharp Mask
locates pixels that differ from surrounding pixels and increases the pixels' contrast by the amount you spec-
ify.  In addition, you specify the radius of the region to which each pixel is compared.  Best setting for
“Unsharp Mask” with Hi-res image (3000 pixels H or V) / “Radius”: 16 / “Fract”: 6.  Decrease “Radius” if
image is smaller (less pixels).  Decrease “Fract” if the filter is too strongly pronounced.  The best practice
is to experiment for yourself.

“Auto Windowing”: This function includes two (2) settings; “B/W threshold” and “Counts threshold”.  This
function is best used when viewing the image with the “Contrast/Intensity combo” and “Windowing” pan-
els loaded on CADI desktop.
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2.1.1 Icons of CADI (continued)

Image Library

This icon calls up the “Image Library” on screen.  The image library contains all the pictures for the select-
ed patient.  To the opposite of the “Status Mount”, all the images are
viewable in the image library.

To insert images in a “Status Mount”, you have to see the image library
on screen in order to drag and drop the images you want from the library
to the status.

Take note that an image deleted in the image library is permanently
deleted.

Within the image library, you can do many operations.  You can access
those options by right clicking on objects.

If you use the right mouse button and click on one of the directories under the patients’ name, you
get a menu like the one on the left allowing you to “Add folder”, “Add folder by preset”, “Delete
folder”, “Rename folder” and “Refresh”.  Be careful when using the “Delete folder” option to
make sure it is empty.  The “Add folder” button will bring a small window asking for a name for
the new directory, simply type the name and click on the little green check mark button in that

window.  The “Add folder by preset” will offer you names you’ve
entered in the configuration of the library in CADI.
When looking at X-rays in the image library, you can always click on
it using the right mouse button to get the “Image Properties”  win-
dow like the one displayed here.

This window contains some interesting information like the name of
the image, the exposure factors (“kV”, “mA” and “t”).  You can also
put some additional information in the “Info” and in the “Keywords”
panel.

The “Info” and “Keywords” can be defined in the setup options that
will be reviewed later on.  You will be able to modify, delete or cre-
ate keywords, info and other types of information.  You will also
have the option to force the person taking the x-rays to choose a
keyword before exiting the x-ray module.  These will be reviewed
later on.

To exit this window without changing anything, click on the door icon.

In the top right corner of the “Image Library” window you will see three (3) icons like the ones on the left.
These icons all have specific functions.

The first one on the left is the trash can.  You can delete any image from the “Image Library” by dragging
it to this icon with the left mouse button and releasing it once on top of the icon.  You will get a confirma-
tion box that you need to agree in order to delete the image.  Important Note: Images removed from the
“Image Library” are permanently gone.  More on this option later.
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2.1.1 Icons of CADI (continued)

Image Library (continued)

The second icon is the magnifying glass.  Clicking on that icon brings up a new window that will allow
searching for specific images.

The first filter used for a search is the “Date Filter”.  Using this fil-
ter can include or exclude images between two dates or on manu-
ally selected specific dates.  In the case of the last option, you will
see a list of all the dates available in the “Image Library” and you
will have to put a check mark in the dates you want to include in
your search.

The other filters will work only if you input a keyword or specific
item to every images taken.  In such a case, you would put a check
mark next to the option you are looking for.  You can include and
exclude certain options by checking them.

Activate the filter by clicking on the green check mark button using
the left mouse button.  Cancel by clicking on the exclamation mark
crossed-circled in red button.

When a filter is activated, the title bar of the “Image Library”
changes color to indicate that a filter is activated.  You can deactivate a fil-
ter by clicking on the magnifying glass icon, all options are back to default,
and then click on the green check mark button.

The third (3rd) icon is the blue arrow.  By clicking on that icon, a window pops up with four (4) options.

These options sort the images you see on the screen in the “Image Library”.  Each time you choose a
new sort order, the “Image Library” will reset itself to the order you’ve selected.  Choose between
“Oldest first”, “Recent first”, “Oldest first(incl. modified images)”, “Recent first(incl. modified
images”, “Ascending” or “Descending” order.  You can experiment with this option until you find the
one that suits your needs.

Bridge

This activates the bridge that you have created.  See the appropriate section in this manual for details.

Reporter

This activates the “REPORTER” module.  This module assists you in creating custom tailored reports for all
your needs.

Exit

This minimizes CADI’s window.  To exit completely, use CADI Data Exit icon or your Practice Management
Software.
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2.1.1 Icons of CADI (continued)

The Contrast / Intensity Combo and the Windowing Tools

One of the best combination of tools in CADI are the “Contrast/Intensity combo” filter and the
“Windowing” filter.  The two can assist in enhancing the image in a very unique way.

If the desktop you’ve selected does not include these tools, you can add them using the top
menu.  Click on “Display”, then on “Desktop Panels” and put a check mark by clicking on both
choices (like picture on the left).

NOTE:  The desktop MUST be unlocked if you want to move these two filter boxes.  If the desk-
top is too small, the actual desktop will have to be changed to a bigger one.

Here (on the left) are the two (2) tools in the best position to use them.  It is easier to use
these two filters if they are on top of each other.

Notice that the top left icon has a red “X” on it, this means that the image loaded in the view-
port is not in 16-bit Grayscale format, so you cannot use these tools.

To change the format of the image to 16-bit grayscale, select the “Edit” menu item.  Once in
the “Edit” menu, choose “Convert current image to grayscale”.  This converts the image to
16-bit grayscale that can be modified using the “Contrast/Intensity combo” and the
“Windowing” tools. 

By changing the image to a grayscale format, the “Contrast/Intensity combo” and the
“Windowing” tools will have a different look and the red “X” will be gone.

Here (on the left) is what these histograms should look like to be able to use them.  Notice
the “mountain” peaks compared to the lines of the prior image.  You can also see that the
“Contrast/Intensity combo” now has a pale blue background.

The “Windowing” tool, the rectangular bar with icons on the left and right of it, can be used
by clicking one side of the bar, holding the mouse button down and dragging the bar on either
side.  You can use the “A” icon to automatically remove the areas without any data.  The dou-
ble square and arrow icon on the left is to reset the “Windowing”.  The main goal of this tool
is to remove the area without data in the image.

The bottom square, “Contrast/Intensity combo”, can be used to tweak the brightness and
contrast of the image.  To do so, simply click the dot in the middle of the window, hold down
the left mouse button and move left, right, up and/or down to see the contrast and the
brightness being adjusted in real time as you move the mouse.

These tools can be used for individual images and must be manually controlled by the user in order to get
the desired results.  The “Auto Windowing” filter can replace the “A” icon of the “Windowing” tool but
nothing can replace the human eye for the “Contrast/Intensity combo” settings.
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2.1.1 Icons of CADI (continued)

The Optio Dentistry Patient Education

By clicking on this icon, you will be able to show your patient an interactive video demonstrating the major
treatment process and what it involves.  This option is only available if you have included it in your CADI
package, it is not a part of the regular application and thus must be purchased separately.  Contact your
CADI representative for more information.

CAM

This icon is to use specific hardware such as Kodak system, Air Techniques video and Eye-Fi.  Consult with
your representative for details.

Filter Selection

When clicking this icon, a new window will appear showing you different filters already applied to the
selected image.  You can choose the filter you want to apply by clicking on the filtered image and then
click on the button “Apply on this image”.  More on this in a different chapter, see index.
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C h a p t e r  3

General Configuration
3.1   CADI Configuration for Your Practice

CADI: Initial configuration and preferences

CADI allows users to customize many parameters for variations in usage.

By default, many parameters are automatically selected to correspond to the most popular setups.  Some
options on the different pictures will not be mentioned in the related text, it will be discussed in a differ-
ent section; please refer to the index.  Parameters not documented are for advanced users only and
SHOULD NOT BE MODIFIED.

3.1.1 Language Settings

The preferred language has been selected during installation.

You can configure or change your preferred language within the CADI application.

From the main screen of CADI, select prefered language of operation as shown in this picture.

Click on “Language”, using the left mouse button, then click on the desired language still using the left
mouse button.  CADI will automatically reload with the chosen language.

3.1.2      General Settings

To configure the general settings of CADI for your practice, using the left mouse button, click
on “Options” and then “Setup” (for users that prefer the keyboard, there is a function key
“F10” for this one, as seen on the picture).

This will open a window with different tabs.  Certain configurations are made using these
tabs.

Once in the Setup screen, click on the “General” button with the left mouse button.
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3.1.2      General Settings (continued)

The first setting we need to change is the “Practitioner information”.  In this
field write the doctor’s name or the practice name.

On that same screen there is a section on the upper right called “File han-
dling”.  Make sure there is NO check mark in the “Move image after drag”
box.  This allows you to copy images from different libraries.

Put a check mark in “Delete files to recyclebin”, “Hide image(s) instead of
delete”, “Delete modified image after reload”, and “Ask before delete
image(s) in acquisition”.  (You can experiment the other options to your leisure.)

Next, click on the tab called “Regional/Registration Settings”.

On this screen, simply be sure that you
have your ”Date Format”.

Choose the correct tooth numbering  sys-
tem by clicking on one of the “flag”
icons.

If on a network, you can select “Search
for a registration key on the network”
and you can add the name of your com-
puter holding the key if you know it and
if you have a USB key only.  You can also
use the IP address of the server.  This
makes the key discovery faster when
entering the application.

NOTE: Your version of CADI should
already be set for teeth numbering since
you’ve had to decide your  country during
the installation.

Click on the “Display Settings” tab and
look at the “Sub-desktop custom names”

section.  You may change the names in this location for each indi-
vidual desktop.

“Prefered monitor nr. :” in “Misc settings” is set to “0” by default,
if you have more than one monitor you can set up on which one to
display CADI through this option.

“Nr of “Recent Accessed Patients” to keep” is where you indicate
how many patients accessed CADI should retain.  (This has nothing
to do with the number of patients you can use, which is unlimited.)

The other options will be described in another section, see index.
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3.1.2      General Settings (continued)

In the mid-screen section you can see nine (9) tabs: “Image
Properties Settings”, “Image Library Settings”, “Status Settings”,
“Viewport Settings” “Positioning guide”, “Teeth chart settings”,
“Archive Settings”, “Magnification”, and “Stamp”.

For now, click on the “Image Library Settings” tab.  The options of
that tab are now displayed.  Make sure you have a check mark in the
option “Monitor / Auto refresh Image Library”.  Make sure there is
no check mark in the option “Activate the global folder by default
in the Image Library”

The tab “Status Settings” contains five (5) options and two (2) should be
activated by default; the “Automatically switch to the scheme used in
the acquisition module” and the “Status full screen show navigator but-
tons”.

La section “Background color” is where you can choose the background
color for the Statuses.  Put the dot in “Custom”, click the color rectan-

gle and choose the color you want.

Now click on the tab “Viewport Settings”

On the right you can see a box entitled “Viewport display
quality”.  For the inital configuration, put a check mark in
the “High” choice.

The interesting option is the “Active viewport background
color”.  This allows you to set the color for the background
of the status mounts.

The other options will be described in another section, see
index.

Go to the “Archive Settings” tab.  It only shows you
what has been archived up to now.  When installing
CADI this box will be empty.

To configure where the archives will be saved you
must click on the folder icon and browse to the loca-
tion you want the archives to be saved.  Once found,
click on the red arrow to put that folder in the list-
box.

The tab “Magnification” will be used only if you have moni-
tors bigger than 20”.  When displaying on a TV or large mon-
itor, you can increase the size of the library and status so that
you can see and read what is on them.  You simply have to
decide the “Magnification factor”.  It is very important that
you have a check mark in “Recreate stamps for new size”
otherwise the images in the frames will stay small.  You have
to close and re-open CADI for the change to take effect.
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3.1.2      General Settings (continued)

Click on the button “Save Changes” at the bottom left to keep all the changes you have made.
Each time you change a setting you should press the “Save Changes” button in order to avoid
losing changes made to certain modules or options if a computer crash should occur.

NOTE: If using a practice management software, you can configure another option.

Click back on the tab “General Settings”.

When using a practice management, after
taking the xray, you might want to display
the schedule again instead of leaving CADI
screen on.  By putting a check mark in the
choice “Send appl. to background if exit
button is clicked”, it will do exactly that.  It
will send CADI to the back of the screen thus
allowing you access to your practice man-
agement.

The same goes with the other option avail-
able: “Simulate an “Exit” button click when ESC is pressed”.  If you put a check mark in this option, it will
allow the user to press the “ESC” key on the keyboard and CADI will go to the back of the screen like if you
would have pressed the “Exit” button.

Of course these options are optional and are to be used accordingly to your preferences.
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3.1.3 Changing Status Names

You may want to give other names to your Status Mounts.  (NEVER change the default Status
Mounts, we recommend to create your own.)

To do so click on the Status Mount icon so that it is on screen.  Use the left mouse button and
click on the “upside down triangle” to get the menu as shown here (on the left).

Using the left mouse button, click on the “New scheme” option.

The following window will appear.

Enter the name and then click on the yellow/gold check mark button.

Go back to the “upside down triangle”, right-click on it and select “Save changes”.

Repeat this process to rename other statuses.  To delete a status name, select it from the list so that it is
active on screen, then select “Delete scheme” from the same menu as before.  More important details on
the statuses in the Status Mount section.

3.1.4 Setting Image Deletion Choice
(Knowledge of Windows file modification is required)

Several Options are available for image deletion.  By default, any image can be deleted in CADI by the user.
By default, these deleted images are sent to the Windows Recycle Bin, when working on the server, and
may be recuperated using Windows Recycle Bin Restore function. (To be sure that your options is config-
ured, refer to this manual in the “File Handling” section (3.1.2) of this chapter.)

NOTE: Images deleted from a workstation are lost permanently.  Any image deletion should be done on
the server only.

The image deletion option can be modified by editing the Ctpcore.ini
file in the CADI directory.  Open this file by double-clicking the left
mouse button.  Locate the line with the text “GER=”

You can change the “GER=” setting to any value between 0 and 3 as
indicated in the chart.  By default, this line is set to “GER=0”.  Don’t
forget to save the file before closing the window.

When restarting CADI, these changes will take effect.

3.1.5 Screen Resolution and Desktops

NOTE: CADI desktops contain the details for which information will be displayed on the screen at a given
time.  

CADI contains pre-configured desktops for most operations with the screen resolutions of 1024 X 768, 1152
X 864, 1280 X 1024, 1280 X 800, 1280 X 960, 1366 X 768, 1440 X 900, 1600 X 900, 1680 X 1050, 1920 x 1080
and 1920 X 1200.  The bigger the resolution the more options you can fit on the screen. (More desktops
becomes available as we create them in newer versions of CADI.)
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3.1.5 Screen Resolution and Desktops (continued)

CADI has also been configured to work at 800 X 600, but there will be no room on the desktop to save images
in mount format, a main feature of the software.  Therefore, not many functions are included for this
screen resolution.  Each module has to be configured independently.

Some desktop selections are optimized for use by endodontists.  Endodontists must select desktops
that contain the word ENDO, wherever they are available.

If the default desktops (1024 X 768) are not used, they must be changed
manually in the configuration by using the following example:

To change the Desktop, simply click “Display” on the top menu with the
left mouse button.

Still using the left mouse button, click on the “Desktop Panels” option.

Go down to the “Load desktop” option and click on the desired size,
with the left mouse button, in the list that appears.

Once again, if you are not using the default desktop size, you will have
to reproduce this on the “Full Screen” view, the “Print Classic” module,
the “Import Picture Directory” module and all other modules being
used.

Additional modules are available and will be described later on in this
manual.

NOTE: This section is only for the main configuration of CADI, a more
detailed explanation will be given later on.

3.1.6 Select Image Formats:

It is possible to change CADI’s default settings.

From the main screen, with the left mouse button, click on “Options”,
“Setup”.  Once in that screen, click on the upper left button called

“General”, using the left mouse button.  On the “General settings” tab, pay
attention to the section called “Image formats”

12/16-bit grayscale image formats - Lossless (JPEG) DICOM compression
24-bit color images bitmap format - JPG compression, may choose PCX
24-bit color images bitmap compression - Preset for moderate compression,
you can change that last setting by sliding the bar in either direction.

When changing parameters, do not forget to click on the “Save Changes” button with the left mouse but-
ton before exiting.  When choosing a compression method, be sure to test that you can open the image
after, some compression are not compatible with other applications.  Be sure to test before using.
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3.2   Image Library versus Status Mount

3.2.1 Differences between the Image Library and the Status Mount

The “Image Library” and the “Status Mount” are the two (2) main windows of CADI.  All the images that
you take, modify or delete can be managed from these components with their own specific properties and
options.  Let’s review the difference between these two (2) components.

First, remember that the “Image Library” is the main “container” for all the images of the selected patient.
Once an operation is applied to an image, or to images, in the “Image Library”, the action is permanent
and will affect the images of the patient.  A good example is if you delete an image from a patient in the
“Image Library”, the image will be permanently deleted, even if it was in one of the “Status Mount” boxes.
Be sure of your action before applying it, there is no way back.

In the case of the “Status Mount”, some operations can be done without affecting the image in the “Image
Library”; it will only affect the image in the “Status Box” you are working on.  The best example that comes
to mind is by selecting a “Status Box” with the left mouse button, and then clicking the right mouse but-
ton on the same image; you can “Remove from Status” which means that the image will be removed from
this “Status Box”; but will still be available in the “Image Library” for future selection and insertion.

Within the “Status Mount”, each image can be positioned in the appropriate position.  Each of these images
can be selected and you can apply certain functions to them by using the right mouse button on the select-
ed image.  You can “Rotate” and/or “Flip” the image and you can also get some information about the
image as in the “Image Library”.  When viewing information about an intra-oral image you will not get the
exposure factor since it is an image taken with a camera.  Only the x-rays will show the details of the expo-
sure(if the x-ray machine allows it and is configured as such).  You can also “Open the file in explorer”;
this will open Windows Explorer and show you one of the file (.mih) composing that image within the actu-
al patient.  An image in CADI always has 3 files, the image itself (“dic”, “jpg”), a “stamp” and a “.mih”.
The “.mih” files are the information file about the image and contains information that can be viewed with
Windows Notepad.  The “stamp_filename.bmp” is a smaller representation of the image in bitmap, it is
this file that you actually look at in the “Status box” of a “Status Mount”.  When manually moving/copy-
ing an image, you need to move/copy the three (3) appropriate files or it will not work.  There are auto-
matic ways of moving/copying images, there is usually no need to do this manually.

If you have not selected the proper “Status Mount” prior to taking x-rays or intra-oral images, the images
will end up in the “Status Mount” that you see on the screen and you can always remove and add images
to it using the “Image Library” once the shots are taken and saved.  Again, all images are saved in the
“Image Library” so you can always work around a “Status Mount” containing badly positioned x-rays or
images.

The “Image Library” allows the creation of folders in which images can be sorted.  When creating those
folders, if you click on the right one prior to taking a shot, it will be saved in the selected folder.  By
default, all images are saved in the patient number folder and can be dragged and dropped between fold-
ers.

You can create “Status Mount” to suit specific needs although most of them have already been configured
to meet the needs of a dental practice.  When in need of a specific “Status Mount”, refer to the section
about “Building your own Status Mount” or ask the help of a CADI professional.  (Some fees may apply.)
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3.2.2 The Image Library

The “Image Library” contains ALL the images taken within CADI and those imported from other software.

Call up the Image Library by left clicking on its icon.  It will open the Image Library window which can be
modified to suit your workspace.

This is the Image Library window and there are 8 areas to review on this window.

AREA 1: This is where all the pictures will be placed by default.
The most recent picture is always the one to the left.  This
order can be changed, see AREA 7.

AREA 2: This is where subfolders can be created to archive
images to your own preferences.  The number shown BEFORE
the parentheses is the PATIENT NUMBER.  The number

BETWEEN parentheses is the QUANTITY of images in the folder.  Sublfolders also have the number between
parentheses.

AREA 3 and 4: These are the Image Libraries you can choose from.  By default, the Patient’s Image Library is
loaded.  The icon on the left, a green square with a page and a pound sign in it, is the Patient’s Library.

The other library available is the Global Library, it is the icon that looks like a planet.

NOTE: When getting in a patient that has images that don’t appear in the Image Library, click the Patient’s
Library icon and you will see the patient’s images.

AREA 5, 6 and 7: These are already described in the chapter about CADI icons.  Refer to pages 35-36 for an
explanation of these 3 icons.

AREA 8 : This is a tooth chart.  Tooth that already had an x-ray taken will be displayed in green on this tooth
chart.  This chart is optional and can be removed within the “Image Library” options.

The Global Library can contain any image.  It is accessible from every station using CADI and images can
be added or removed from any station as well.  The idea behind the Global Library is to give the user a
central location where he can keep images to be used during case presentations and patient education.

To add an image to the Global Library, simply choose it from the Patient’s Library and move it to the Global
Library icon using the left mouse button.  This will create a copy only, the image will remain in the Patient’s
Library as well. The same applies to removing images, except you move the image to the trash can icon.
You can also right-click an image to move/copy it to the Global Library.

The important point to remember is that the Image Library contains ALL the images of ALL the patients.
Even when removing an image from a Status Box, the image will stay in the Image Library, untouched.  If
you delete it from the Image Library, the image will be permanently deleted.

NOTE: Deleting an image from the patient’s library does NOT eliminate the image, it simply hides it from
the users.  This is a security precaution to avoid completely losing the image when not sure.  Once a month
or so, someone should discard all the deleted images from the server using the “ImageLib Tools”, a new
module of CADI. Explanations on how to use the module in its own section.
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3.2.3 The Status Mounts

(Image has been reduced for space purpose)

In this section we will only compare the Status Mounts to the Image
Library.  If you are looking to create or modify a Status Mount, refer
to “Building your own Status Mount” in this manual.

Status Mounts are image holders that can be fashioned to your needs.
CADI includes the most common ones used by dental professionals.
To access the different Status Mounts available, click on the arrow
next to the name of the mount (in this example AAO) and choose the
one you want to look at.

The Status Mounts were developed by analysing the different kinds of exams used in an office, and making
it easier by automating the process of image taking.  Whether it is an intra-oral image, an x-ray, a pan or
a ceph, there are Status Mounts for all of them.

The default Status Mounts, included in CADI, have been designed similar to the anatomical layouts often
used in dentistry.  The advantage of the Status Mounts over the Image Library is that you can get a fast look
at your patient’s case instead of navigating through the Image Library to find each images.  This way, the
information that you need is available at a glance.

Another advantage of the Status Mounts is that each image is contained in its own box and can be
accessed/modified independently and without affecting the original.  Within each Status Box you can:

• “Remove from status”:  Remove a picture from within the StatusBox without deleting it from the 
patient image Library;

• “Rotate 90°, 180°, 270°”: Rotate the picture within this frame.  This affects the original picture 
without having to save it.

• “Flip Horizontal, Vertical”: Flip the picture within this frame.  This affects the original picture 
without having to save it.

• “Image Properties”: Change some of the pictures properties.  You can change the name of the 
image, put additional information, keywords, and exposure factors.  Changes will affect the ima-
ge properties.

• “Open file in explorer”: Opens the patient directory in Windows Explorer to show you the files.

There are by default nine (9) Status Mounts, ready to use, already setup for the user:

Hygiene
Intra-oral cam
Ortho
Ortho 9
Pan ceph
Photos
X-rays
X-rays primary
X-rays Vertical bite wings (bitewings)

These mounts are ready to use and should not be modified.  You can create additional Status Mounts but
this will be discussed in another section, please refer to the index.
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3.3   Setup Menu

3.3.1 The different components of the Setup Menu

The “Setup” menu contains everything to configure CADI and its modules.

There are five (5) important parts to this window:

1: The “General” settings button.
This one is on its own since it
affects the whole application.

2: The “Modules” button.  This is
the list of modules included in your
CADI package.  This list varies
accordingly to the modules you
purchased and the equipment you
are using.

3: This is the “Options” window.
This window changes with every
module.  Each module has its own
options, but they will always
appear in this section.

4: The “Save Changes” button.
Each time a change is made to ANY
module or options, you need to
click on this button in order to save
the changes.  If you forget to click
on the “Save Changes” button,
none of the modification will be
applied and they will have to  be
redone.

5: The “Exit” button, to exit the “Setup” menu window.

These are the main parts of the “Setup” menu window.

The “Modules” section is very important since it contains the options window for each individual compo-
nent.  This section is different for everyone since it is adapted to the equipment you are using.  We will
not discuss the actual hardware component in this manual because there are too many of them.

Instead, let us review the common modules that everyone has by default in CADI.  The Reporter module
has its own chapter, see index for details.

The different x-ray, pan and scanner modules will not be shown in this manual since they are specific to
each hardware independently.  Be aware that when using CADI with the USB Key configured for YOUR prac-
tice, you should only see the modules that you are using.
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3.3.1 The different components of the Setup Menu (continued)

The “Print Classic” module button will bring up a window to configure some default settings for printing in
CADI.

(Image has been reduced for space purpose)

“Borders”: “Fixed” means the borders will stay the size of the
box.  “Smart” means the borders will follow the image size
instead of the box.

“Annotations”: “Printed” will print the annotations of the images.
“Not Printed” will not print the annotations of the images.

“Image date notation” : You can choose what date will be shown
on the printout with the options here.  “Original Date” or
“Modified Date” if modified image exists” will display the origi-
nal date or if it’s been modified it will show you the modification
date.  If you choose “Original Date (Modified Date)” the original
date will be printed and the modified date will be in parentheses.

“Pics/Page”: You can choose to print 1, 2, 3, or 6 pictures per page, this is where you choose the default.
(Changeable with each print.)

“Printer Selection”: “Windows default” will use the default printer configured in Windows.  If you put the
dot in the other choice, you’ll have to click on the drop down arrow at the end of the field and choose the
printer that you would like the “Print Classic” module to send the printouts.  This will only affect THIS mod-
ule, not all the printing within CADI.

“Reduce Printer Requirements”: To check for certain printer with low memory.

“Optimize Image Size”: This option allows CADI to resize the image according to your printers maximum
DPI setting.

“Print Quality”: Should always be set to 100% for best quality printouts.

The “Salvage” module button will bring a window to configure the salvaging option of CADI.

(Image has been reduced for space purpose)

“Desktop File”: Like in other modules, you can choose your desktop resolution
for that module.

“Enable Salvaging”: This option is activated by default in CADI and must be
activated.  This allows CADI to recuperate images when a crash occurs.  With
this option deactivated, the images would be permanently lost.

NOTE: The “Salvage” module is included as a security feature to address computer crashes.  Be aware that
most crashes are caused by defective hardware or corrupted Windows files.  Even when the error message
comes within CADI it doesn’t mean that CADI is the cause, an error message is sent by the hardware  to
the computer and then from the open software to you.  A periodical clean-up of the computers will also
limit the possibility of a crash, consult your computer administrator.
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3.3.1 The different components of the Setup Menu (continued)

The “StatusFullScreen” button will bring a window to configure the Full Screen Status option of CADI.

(Image has been reduced for space purpose)
“Desktop File”: Like in other modules, you can choose your desktop
resolution for that module.

“Repaint While Sizing”: When activated, this option redraws the
picture while the container box is resized so that you can see the
changes while working.

“Autoload Presetfile”: This loads the default Status that comes with
CADI.  This can be modified.

“Autoset Orientation”: This automatically loads the preset file in
the orientation selected here.  This option can be turned “Off”.

“Load annotations”: If activated it will display any annotations
inserted on the image(s)

“Use active status filter”: When checked, any filter applied to the
status will be also be applied to the Status Full Screen.

Under the tab “General settings” there are two (2) options:

“Background Color”: You can specify the color of the background for the onscreen display of the Status Full
Screen.

“Logo image”: This is where you can insert a logo of your practice that you will be able to position on the
Status Full Screen screen.  If chosen, this logo will be printed as positioned on the screen.

The “Printer settings” tab has many options to configure.

“Printer”: Choose here which printer the full screen status will print on.
“Default” will use the default printer configured in Windows.  For a differ-
ent printer, click on the drop down arrow at the end of the field and choose
the printer that you want for this module.

“Print Borders”: To configure the borders, click the “Test” button at the
end of the field “Printer”.  On the print you will see multiple lines and
their corresponding offset from the border.  Use the first visible value and

enter it in the corresponding border box.  It is possible that you see from 1-15 on the top of the paper, and
only 11-15 on the bottom of the paper, then enter 1 for the top value and 11 for the bottom value.  Do the
same for the left and right margins.

“Print Image Borders”: When checked, it allows CADI to print borders around the pictures.

“Print Info Footer”: This option prints information on the page footer like the patient’s name, the practi-
tioner and the exam date.

“Reduce Printer Requirements”: To check only if you use an older printer with low memory.

“Background Color”: To specify the background color to print. (White is preferable to save toner.)

“Optimize Image Size”: This option allows CADI to resize the image according to your printers maximum
DPI setting.

“Print Quality”: Should always be set to 100% for best quality printouts.
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3.3.1 The different components of the Setup Menu (continued)

The “Layout export settings” tab has 3 options that you can configure.

“Default Destination”: This is the place where you want to save the full
screen status that are created.

“Output Resolution”: This is the resolution the full screen will be shown
in.  This should always be set to large for the best resolution possible.

“Output Quality”: This is the quality level of the image of the full screen
status that you will save.  This should be set to a high setting to keep the quality high.
(All these settings can be changed while exporting.)
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3.3.1 The different components of the Setup Menu (continued)

The “Bridge” button will bring up the bridging window to allow bridging of third parties software to CADI.

(Image has been reduced for space purpose)

“Bridge description”: This field is to type in the name of
the bridge to be created.

“New”: Clicking on this button creates a new object in
the “Defined bridges” section.  Type in a name in the
field to identify this new bridge.

“Delete”: Clicking this button deletes the “Defined
bridges” that is highlighted (selected) when you click.
As an example, in this picture, clicking on “Delete”
would remove the “Optio” bridge because it is highlight-
ed (selected).

“Defined bridges”: This is where the bridge you create,
and the default ones, are listed.  When creating a new
bridge, its given name will appear in this list.  To delete
a bridge, highlight it (select it) and then click the
“Delete” button on top right

Under the “Bridge description” there is a rectangle with six (6) actions listed in it.  These are all the oper-
ations that can be assigned to a bridge.  Here is a short description of what they do:

“Create a toolbar button”: This option, if checked, puts an icon in the icon pad of CADI to activate the
newly created bridge.

“Create a menu item”: This option, if checked, puts an item in the menu of your choice.

“Create a file”: This option is to create a file with the name and content specified.  Can be used to cre-
ate a script or batch file of just a file needed for a bridge.  Advanced users only.

“Copy a file”: This option is like a macro.  It allows you to copy a file by clicking on bridge icon that you’ve
configured.  

“Launch an application”: This option, the most used, starts a third party software while in CADI.

“Send a Windows Message”: Sends Windows messages to an application.  Basic knowledge of the Windows
Messaging System is required.  Can be used to send a “button click” to another application.  Advanced users
only.

Each of these options have their own window.  On the next page we will review the most used options
offered in those different windows.  (For additional instruction contact your CADI representative.)
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3.3.1 The different components of the Setup Menu (continued)

(Images have been reduced for space purpose)

“Create a toolbar button”

“Button Image”: This is where you choose what image to use as an icon in
CADI for the bridge you’ve created.  You can leave the one by default or you
can choose your own.  The image must be 32x128 pixels.

“Button Hint”: The text that appears when hovering over the icon with the
mouse.

“Create a menu item”

“Menu Description”: Specifies the name of the item in the menu.

“Menu Parent”: This is where you choose in what menu you want your bridge to
appear.  You can put your bridge in any of the available menu item.

“Copy a file”
“Source File”: This is where to put the filename of the file to copy with
command-line options next to it.  You can use the three (3) dots icon to
browse to the location of your file.  You can also use the question mark
icon to see a window with a small description of the available options.

“Destination File”: This is the destination path for the file you’re copying
with command-line options.  Use the three (3) dots icon to browse to the
destination of the file.  You can also use the question mark icon to see a
window with a small description of the available command-line options.

“Overwrite Destination if Exists”: This option overwrites the destination file if it has the same name.

“Launch an application” (most commonly used)

“Target”: This is where the application that is to be launched when the
bridge is selected.  Browse to the location of the application (.EXE) by
using the three (3) dots icon. 

“Command Line”: You can add command-line options to the launch of the
application.  Use the question mark icon to see a window with a small
description of the available command-line options.

“Start In”: This is where the application launches from.  It is usually the same directory as the application.

“Run”: This tells CADI if you want the application to run in “Normal” size, “Minimized” or “Maximized”.
This setting is up to you and what you want to do with the application launched.
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3.3.2 The Optimize Module Overview

The “Optimize” button will bring up the optimization window to allow the user to choose automatic or
manual optimization and decide what will be applied as filters.

(Images have been reduced for space purpose)
1 - These are the two (2) available tabs, “Action
Presets” and “Appearance”.  We will start by look-
ing at the “Action Presets” window first.

2 - There are 5 different optimize tab that can be
preset to do specific actions in CADI.

3 - This field is to type the name you want to give
to the tab you are configuring.  Click on the green
check mark button at the end of the field in order
to save the name, it will then appear on the tab
itself.  These names will also be the ones that
appear when accessing the manual optimization
function on CADIs’ icon pad.

4 - These are the actions (filters) that can be
applied to each tab.  You can apply multiple actions
to the same tab.  Add an action by configuring its
options and then clicking on the button at the end
of that action line.  Some actions have multiple
options, see the “Filters” icon in this manual.

5 - This window contains the actions that the opti-
mize tab will perform.  Each time you add an action to the list, it gets added to the bottom of the list.
Since the order in which the filters (actions) are applied influences the result, you must try them manual-
ly before automating the actions.

6 - The “Delete” and “Clear” buttons can be used to delete an action in particular or to clear all actions
for a specific tab.  To delete an action, select it with the left mouse and click on the “Delete” button.  To
clear an entire list of action, be sure to be on the right tab and then click on the “Clear” button, the whole
list of actions will disappear.

Every change you make to the optimization tabs will be saved only if you click on the “Save Changes” but-
ton at the bottom left.

A few tabs have product names in them already.  These are the units that were used to set some predeter-
mined optimize so that you can try and see what they actually do.  All or any of these can be modified.

The optimization process is based on trial and error, so it cannot be created in advance.  Before applying
any filter (optimization) to an image, the image should already be clear and visible.  These filters are only
created to enhance an image that is already acceptable.  The filters cannot fix a bad image, they could
make it look better then it actually is, however the quality of the initial image will affect the final result.
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3.3.2 The Optimize Module Overview (continued)

(Image has been reduced for space purpose)

1 - The “Appearance” tab is the tab used to set
the default optimize button and also the default
action for each module.  This is where the actions
can be automated.

2 - The “Default Core Preset” is where you choose
what button will be the default one shown in the
icon pad of CADI.  Even if you choose a button by
default here, you can always use ANY of the avail-
able button in the icon pad by clicking on it with
the mouse and holding down the button to see all
the available ones.

3 - This is the “Module Presets” section.  The main
rectangle contains the list of modules that you
have in  CADI.  To apply an action automatically to
a module,  first choose the module in this rectan-
gle and highlight it with the mouse.

4 - The user decides here what optimization will
be applied to the module selected in point 3.
After selecting the module in point 3, put the
check mark in the optimization (tab) name that

your actions are, (remember last page, you can name all the tabs to your preference, this is the name in
question), and then putting the dot next to your optimization (tab) choice.

NOTE: If you select a module, then put the check mark in the desired optimization but don’t put the dot
also, the dot will stay in “No optimize” and thus no actions will be performed automatically.

If you do not choose the module prior to selecting the optimization, CADI will apply your selections to the
first choice in your list of “Module Presets” so be sure to always choose the module you want to automate
before applying an optimization to it.

Optimization is based on personal preferences so it cannot be covered by the technical support group.  This
is a tool to be used on a trial and error basis until you find the right combination.  An optimization process
that works with some equipment in one room might NOT have the same reaction in another room; all equip-
ment needs to be tested independently.  Please keep this in mind before applying automatic optimization
to untested rooms.

Once again, before applying any filter (optimization) to an image, the image should already be clear and
visible.  These filters are only created to enhance an image that is already acceptable.  The filters should
not be used to fix a bad image and make it look better than it actually is; it should be used to enhance a
good image.

For advance filtering consult Chapter 9 of this manual.
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C h a p t e r  4

X-Rays

4.1   Configuring your Digital Sensor in CADI

4.1.1 Configuring the Hardware for your Digital Sensor

NOTE: If you are using digital X-Ray equipment not listed in CADI, please
contact CADI technical support and request documentation for its installa-
tion and configuration.

First, make sure that your Digital Sensor appears in the list of sensors avail-
able in CADI by doing the following:

Using the left mouse button, click on the word “Options” on the top menu
and then select “X-Ray Acquisition”.

In the sensors menu, locate your sensor.  Once you find it, click the left
mouse button to select your default sensor.

In this example, the most popular sensors that are ready for use in CADI are
listed.

When you get your copy of CADI, you will get a USB Key that activates the
different modules of the software.  This key will eliminate all the sensor
choices listed in the example and leave only the ones you are using.  This
makes the selection a lot easier when configuring your sensor in the soft-
ware.

Each sensor has its own configuration module in CADI, (once again in the fol-
lowing examples you will see most of these choices, but when you get your
CADI package and install it, only the sensor you are using will be listed in
the configuration modules).  Let’s look at an example of these modules.

Using the left mouse button, click on “Options” on the top menu, then click on  “Setup”.

This will bring up the setup screen described in parts in Chapter 1, point 1.2.2 and in Chapter 3,
point 3.1.2.
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4.1.1 Configuring the Hardware for your Digital Sensor (continued)

As mentioned earlier, each sensor brand has its own configuration module.  Once you get in the setup
screen, you will see some rectangle buttons on the left side of the window.  One of these should be corre-
sponding to your sensor brand. (If your sensor brand doesn’t appear in the list, please contact CADI
Technical Support)

For this example we are displaying the module configuration
of the Optimum sensor (MDX). (Once again, each module has
its own screen with its own options so these will not be dis-
cussed in this manual.  Please consult the installation instruc-
tions that came with your sensor.)

The only options that will be the same for each module are
the ones at the bottom in the section “Module appearance”.
These options should all be checked so that your sensor
appears in the list and the menus.  This is already checked by
default in CADI.

Every time changes are made to a CADI module in the Setup
window, you MUST click on “Save changes” for the modifica-
tion to be applied.

Once your sensor module is configured, you can go in the x-ray module of your choice.  There are two (2)
ways to take x-rays; single x-rays or mounted x-rays.  The main difference between them being that the
mounted x-rays will use the Status Mounts of CADI to take the shots thus allowing full exams easily, while
the single x-rays will allow you to take many shots of different tooth without any particular order.

The two (2) icons are described in the “C h a p t e r  2 : Icons Description”, section “2.1.1 Icons of CADI”.

Let’s review the Single X-rays module to see the available options in the module.  Once again, the options
we will cover are the ones that are available in EVERY x-ray module.  We will NOT cover the individual
options of each different sensor.  The options of your particular sensor should be explained in the documen-
tation that came with your sensor.  If you are missing that information, please communicate with your rep-
resentative or call CADI Technical Support.

The single X-ray module is the one that looks like the radiation sign.  By putting the mouse arrow over this
icon, the message “X-ray acquisition” appears.

Clicking on this icon brings up the single acquisition window.  If your sensor is already selected, connected
and configured correctly, after a few seconds you will see the message “Ready For Exposure” at the bot-
tom of that screen.
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4.1.2 Reviewing the General Options of the Acquisition Window

Clicking on the “X-ray acquisition” icon brings up the x-ray acquisition window.  Like all the windows in
CADI, it is customizable according to your preferences, but this part will not be covered in this chapter, see
the index for details.

(Picture not same size for space purpose)

This is what the x-ray acquisition window looks like by
default.  Some options are different according to the man-
ufacturer of the sensor.

On the left you have the tooth chart to identify the images
you are taking prior to taking them.

On the top right is the “Viewport”.  This is where the x-ray
taken will first appear.

At the bottom right is the “Image Library” where all the
images of the loaded patients are.  All the images that will
be taken will be archived in this library.

At the bottom left are the “Grab” and “Exit” buttons,
which are self-explanatory.

Completely at the bottom, there is a wide bar with a “0”
and the “Ready For Exposure” message.  The “0” is the
tooth number selected on the tooth chart in this module.
The message bar will display all the messages exchanged
between the software and the hardware.  If a problem
occur, the message will let you know what is wrong.

There are three (3) options on the top menu bar; “File”, “Edit” and “Desktop”.

In the “File” menu, the only available option is “Exit”.  It is used this to exit the module.

The “Edit” menu allows you to set the “Auto Optimize” ON or OFF.  By default, there
should not be any optimize applied to your initial x-ray acquisitions.

(The optimization filters are covered under a different chapter of this manual.  Please refer to the index
of this manual for more information on the optimization.)
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4.1.2 Reviewing the General Options of the Acquisition Window (continued)

The “Desktop” menu contains more options.  The first one is the “Visible
Controls”.  In this particular module, it only offers you to display or not the
“Teeth Selector”.  By default, this option is on in CADI.

Next, the “Load desktop” option allows the user to display different size of
the window according to your Windows settings.  Choices are “1024 x 768”,

“1135 x 856”, “1152 x 864”, “1280 x 1024”, “1280 x 800”, “1440 x 900”, “1680
x 1050” and “1920 x 1200”.

The “Save desktop” option saves any modification done to the actual desktop
loaded.

The “Save desktop as ...” option allows to save a new desktop with a new name.

The most important option in this menu is “Lock desktop”.  When activated the
desktop cannot be changed.  To make changes to the desktop, you MUST deacti-
vate this option by clicking it with the left mouse button.  To be sure that it is
turned off, go back to the menu and the “key” icon should not be pressed, indi-
cating that you can make changes to the desktop.

When making changes to the desktop, do not forget to lock the desktop back after the modifications are
done, and to save it so that the changes made are kept.  (Forgetting to save the desktop will reset it to
the original default one of CADI.)

The options available in the “X-ray Acquisition FMX”
are the same.  We will only review the different com-
ponent of the “X-ray Acquisition FMX” window.

On the top left is the tooth selector.

On the top right is the “Viewport”.

At the bottom right is the “Status Mount” (see appro-
priate chapter for detailed information).

At the bottom left are the “Grab” and “Exit” buttons,
which are self-explanatory.

Completely at the bottom, there is a wide bar with a
“18-46” and the “Ready For Exposure” message (not
shown here).  The “18-46” is the tooth number select-
ed on the tooth chart in this module.  The message bar
displays all the messages exchanged between the soft-
ware and the hardware.  If a problem occur, the mes-

sage indicates what is wrong.
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4.2  Taking X-Rays

4.2.1 Taking X-Rays with FMX

NOTE: The first time you use CADI and a digital sensor to take x-rays, turn down your x-ray exposure time
by about 2/3 of the time exposure required for film.  If the resulting image is too light, generally it is
underexposed.  If the image is too dark, generally it is overexposed.  Using less radiation than with film,
x-rays will be more sensitive to differences in exposure and you will probably develop 3-4 different set-
tings for different size patients and different areas of the mouth.  Some x-ray machines will keep a vari-
ety of settings to facilitate this process.  Periapical x-rays of upper molar will require a higher dosage of
radiation.

There are two (2) ways to take X-Rays in CADI:  the Single X-Ray method or the Full Mouth (FMX) method.
(Both methods described in Chapter 3.2 of this manual.)  We will start by describing the most used method,
which is the FMX method (Full Mouth X-rays).

From the CADI main screen, select the “X-Ray Acquisition FMX” icon.  This will bring up the acquisition win-
dow that looks like the following.

(Image reduced for space purpose)

This window is different for every sensor.  Some have options that oth-
ers don’t have.  Please refer to your hardware manual for specifications
on the options for your type of sensor.

For a more detailed explanation of this window, please refer back to
Item 4.1.2 of this manual.

The Status Mount window will be the same with any sensor.  The status
bar also will always be there to give you the messages from the hard-
ware.
(See section 4.1.2 of this manual.)

If necessary, select the “Status Mount” in which you wish to place x-rays from the drop down
menu.    Each of these have a sequence attached to it by default.  If you make changes to any
settings, you should save the new “Status Mount” under a different name.  Consult the section
about creating your own “Status Mount”.

If needed, select the “Sequence” in which you wish to take x-rays from the drop down menu.  Each
“Status Mount” has its own “Sequence” already defined, usually you should not need to make any
changes to these.  If however you want to create your own “Sequence”, refer to the section about
creating your own “Sequence”.
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4.2.1 Taking X-Rays with FMX (continued)

When CADI is ready to receive the x-ray information,
the text bar on the bottom of the screen will indi-
cate: “Ready For Exposure...”

When ready, depress the button on the x-ray machine
to take a shot.  The x-ray appears and you will be
taken to the next tooth in the sequence. To take a
single X-ray, you should use the method described
later on in this chapter.

Repeat the process for additional x-rays.  When you
finish taking x-rays, three options are available:

• You can press the “Exit” button.  From the window that pops 
up, select “Save All” which will save all your x-rays and exit to the 
CADI main screen, displaying the x-rays that were just taken.

• You can also review all your images.  Instead of selecting “Save All”, 
review the x-rays you have taken one by one choosing either “Save” 
or “Delete” for each individual x-ray.

• A faster way is to press the “Auto Save&Exit” button.  This automat-
ically saves all x-rays and brings back the CADI main menu in the 
same patient.

It is possible to take images “out of sequence”.  If you want an image of a particular tooth, click on any
box within the mount and take an x-ray.  The x-ray will be oriented and placed in this box.

4.2.2 Taking X-Rays with Single X-Ray Capture

This setting is generally for endodontists who will typically take repetitive images of the same tooth
during a procedure.

If not already done, connect the sensor to the computer.

Using your preferred holder system (Rinn, Wingers, etc.), position the sensor intra-orally for the first image
at the desired location.

From the CADI main screen, locate the “X-Ray Acquisition” icon and click on it with the left mouse button.
The X-ray Acquisition screen will appear.
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4.2.2 Taking X-Rays with Single X-Ray Capture (continued)

The Endodontic desktops are using only the Image Library so you will
not see any Status on those windows.  Since Endodontists takes
many images of the same tooth, the statuses were not useful for
them.

X-Ray Sensor Selection: If the sensor interface allows it, you might
have to choose the sensor you are using.  This option is only avail-
able with certain sensors.

Tooth Number Selection: Click on the image, the tooth or combina-
tion of teeth you want to take an x-ray for using the left mouse but-
ton. 

When CADI is ready to receive the x-ray information, the text bar
on the bottom of the screen will indicate: “Ready For Exposure...”

When ready, simply depress the button on your x-ray machine to take a shot.  The x-ray appears thus allow-
ing you to take another one, or to save this one and exit.

Repeat the process for additional x-rays.  When you finish taking x-rays, three options are available:

• You can press the “Exit” button.  From the window that pops up,
select “Save All” which will save all your x-rays and exit to the
CADI main screen, displaying the x-rays that were just taken.

• You can also review all your images.  Instead of selecting “Save
All”, review the x-rays you have taken one by one choosing either
“Save” or “Delete” for each individual x-ray.

• A faster way is to press the “Auto Save&Exit” button.  This automat
ically saves all x-rays and brings back the CADI main menu in the 
same patient.

These are the two (2) methods that can be used to take x-rays/I-O on a patient.  Both methods are valid
and depend only on the required exam.

You should get familiar with both interfaces so that you can choose the one best suited for you.  Be sure
that you have chosen your sensor type prior to clicking on the acquisition icons, otherwise you will get an
error or enter the wrong window for your sensor type.
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C h a p t e r  5

Intra-Oral Cameras
5.1   CADI Configuration of Intra-Oral Camera

5.1.1 Configuring your Intra-Oral Camera in CADI

To configure an Intra-Oral camera in CADI, use the left mouse button and click on
“Options” in the menu at the top, then click on “Video Still Capture” and finally on
“WDM Still Cap”

The “VFW Still Cap” option is available and designed to operate CADI with different
video capture cards.  This option is not recommended as WDM video capture cards are
inexpensive and offer better image quality than VFW.

5.1.2 Setting WDM Capture Options

Select “Options”, using the left mouse button, then click on “Setup”.  Once in the setup screen, scroll
the list on the left side, locate and click on the button “WdmStillCap” with the left mouse button.  A
screen like the following will appear:

“Desktop File”: Select a DSK file that corresponds to your screen
resolution and pedal type.

“Grab as grayscale”: Check this option to capture only in black
and white (B/W).

“Mirror”: When using an intra-oral camera that mirrors (inverts)
images, this setting activates the mirror function and puts the
image back to an optically correct orientation.

“Fullscreen mode”: Check this option to open the Intra-Oral mod-
ule in fullscreen mode automatically.

“Enhanced quality”: This option should always be activated so
that the quality is set to maximum.

“Check for DirectX x.x”: This option allows CADI to verify if your
system contains the needed version of the Microsoft DirectX
application which is used for the WDM drivers.

“Allow multiple images on a status frame”: This option, near the bottom, should always be checked, it
allows you to capture more than one image per frame.

The other options are for very advanced users only and should not be modified.  Always click on “Save
Changes” button after making modifications to a configuration, otherwise they will be lost.

NOTE: Certain options will differ depending on the capture card.  If some options display “*UNUSED*”, it
is only because the capture card does not offer that option.
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5.1.3 Single or Double Foot Pedal

NOTE: Use only foot pedals that have been designed for CADI.

On the same configuration window, there is a tab called “Foot Pedal”.
Clicking on that tab allows you to configure your foot pedal to be used
with your intra-oral camera and CADI.

“Foot Pedal Connection Type”: This is where the connection of your
foot pedal is specified.

“Game Port”: This setting has no other configuration to it.

“Serial Port”: If using the serial port, it must be configured in the
“Serial Port Settings” section.

“Serial Port Settings”: This section is only used if the foot pedal is con-
nected to a serial port (COM).  If it is, refer to the manufacturer
instructions to configure the COM port.

Always click on “Save Changes” button after making
modifications to a configuration, otherwise they will
be lost.

The screen used for both types of pedal is slightly dif-
ferent, but both pedals can be used on both screens.

The double foot pedal offers you a way to naviguate
through the different status boxes using the foot
pedal; no need for the mouse with this method.  One
pedal moves from frame to frame while the other cap-
tures when required.  You can also change the direc-
tion that you are moving through frames using the
same foot pedal.

The single foot pedal offers a single capture capability.
You cannot naviguate through the teeth chart and take
pictures of different teeth as with the double foot
pedal.  You have to choose with the mouse the tooth
that you are exposing and then grab with your foot
pedal.  You can use the “Automatic Advance” function

to go to the next tooth in the chart automatically, but you will not be able to go backward, it will follow
the numbering on the chart automatically.  The main difference between these two options is the naviga-
tion factor.  Depending on the kind of exam you are usually doing, you might prefer the double foot pedal
over the single one.
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5.1.4 Optimizing Images

CADI has a predetermined setting of sophisticated filters which can be added to intra-oral images
automatically or manually.  By default, images are not optimized upon acquisition, however this option can
be made automatic once you’ve determine that the filter is appropriate.

Should the user wish to acquire images with a filter applied, (it is also possible to acquire images without
the Optimize filter and then click on one of the button to optimize an image) which is the default setting.
Test before applying any of the filter permanently.  A filter applied at the acquisition CANNOT be undone
while a filter applied to a saved image can be undone.

To activate the automatic Optimization function for all intra-oral camera images, do the following:

Using the left mouse button, click on “Options” in the top menu and then click on “Setup”, (or press
“F10” on the keyboard).  This will bring up to the “Setup” window that contains all the different
modules you can configure.

Once in the setup screen, naviguate through the buttons on the left, find and click “Optimize”, which
will bring up the optimization window.

On the optimization window there are two (2) tabs.  Click on the
“Appearance” tab.

The first section, “Default Core Preset”, specifies what button will
be shown by default on the “Optimize” icon.  This setting can be
modified each time the icon is used simply by pressing and holding
the left mouse button on the icon and selecting the right optimize
filter number.

The bottom part, “Module Presets”, is the automization part.  This
is where you can configure each module to be optimized or not.

To do so, as in the example, select the module first in the “Module
Presets” rectangle and click on it.  The module must become high-
lighted.  Once selected, choose what will be applied to it using the
right options.

To activate the optimization in the intra-oral camera module, select “WdmStillCap v3.03” in the rectangle
and highlight it.  Then in the options, select the filter you want to be applied automatically, in the exam-
ple “Darken” by clicking on its check box and then by clicking on the circle to the left of it.

Do the following for every module you want to configure: choose the module in the rectangle on the left,
then choose the filter name(even if you won’t use any), then click on the choice you want for that filter,
either the filter itself or the “No optimize”.
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5.2   Using your Intra-Oral Camera in CADI

5.2.1 The Intra-Oral Window

If you are using a different foot pedal than the one sold for CADI, it might not work accordingly to the
instructions in this manual.

Be sure to have completed the steps in 5.1.1 to make sure your camera is already identified by CADI.

Be sure to already be in CADI, in the patient you want to take images for, then on the icons pad, locate the
“WDM Video Still Capture” icon. (It looks like the one on the left of this page).  Once you have located it,
click on it with the left mouse button.

(Image reduced for space purpose)

The WDM Video Still Capture window will appear.  Let
us explore the different parts of this window.

1: The main menu of the window to access different
options.  (See below.)

2: The Main viewport where the live image will
appear.

3: The Capture viewport where the image you capture
will be shown to you.  This image changes with each
new take.

4: This is the Sequence menu, (see Status Mounts in
the Index).

5: This is the Status Mounts menu, (see Status Mounts
in the Index).

6: These are the status boxes contained in the Status Mount.  Each image you take goes in one of these in
the order indicated by the larger numbers in the box.  Each Status Mount has its own set of status boxes
and its recording sequence that goes with it.  (See Status Mounts in the Index for more information.)

7: This is the tooth chart that allows the interface to identify and name the tooth you’re exposing.  You
can also click on a status box and then choose a tooth range on this chart thus naming the image accord-
ingly.

8: This is the button to use to have the live image full screen.  The full screen mode will focus the live win-
dow in a screen resolution of 640x480.  Since Windows resolution is higher than this nowadays, you will only
see a bigger window but it may not fill the screen.

9: This button grabs an image with the mouse instead of a foot pedal.

10: To exit the Intra-Oral module.
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5.2.2 The Intra-Oral Window Main Menu

The first item in the menu is “File”, which contains only one option; “Exit”.  It is exit the
Intra-Oral module, not CADI.

The “Options” menu contains more options:

“Grab as grayscale”: This captures the image in grayscale (B/W)
“Mirror after grab”: This option mirrors the image once captured.  This is especially practical
for the cameras that produce mirrored images.  This process can be set to be automatically
applied, see the Intra-Oral Camera configuration in this chapter.
“Enhance quality”: This enhances the quality of the image displayed.  Notice the check mark
because the option is already selected in the WDMStillCap configuration module.

The “Device Setup” and “Video Properties” options will be reviewed later in this chapter
because they include too many options of their own.

The “Edit” menu contains only the “Optimize” option.  You can always choose to auto-
optimize an image or not, using this menu.  Once you have determined the kind of opti-
mization you want to use, you can set it up to be applied automatically.  See the Index.

The “Desktop” menu contains many options.  The lower part about desktops is the
same as in every CADI menu; refer to the section about the main CADI window and
menu in this manual.

“Visible Controls”: This allows the user to load different controls on the acquisition
window.

The available “Controls” are:

“Image library”: Brings up the Image Library. (Selected in our example.)

“Mount”: Brings up the Status Mount. 

“Teeth”: Brings up the tooth selector chart. (Selected in our example.)

“Logo”: This option is for future use.

“FullScreen”: This is to have the button “Full Screen” displayed on the capture window.  By default, CADI
is configured to show this button. (Selected in our example.)

The “Preset” option is only available if you have created some preset camera configurations.

The “Reset” menu option doesn’t have a sub-menu.  When clicking on this option, live video will reset
itself.  This is convenient especially when adjusting the settings of the actual camera.  This option is rarely
used and is mainly for testing purposes.
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5.2.3 Device setup and Video Properties

As mentionned earlier, “Device Setup” and “Video Properties” have their own options,
explained here briefly.  Note that options available are different depending on your capture
card.  The options that are the same with any card will be mentionned.

When clicking “Options” and then clicking “Device Setup”, the configuration screen of your
video card in CADI appears.

(Image reduced for space purpose)

This window is the same for all capture cards.  The “Quick Setup” tab will
appear by default.

Your video capture device should be listed in the rectangle.  We will not use
this tab for the configuration, so if your card is not listed, it is not a prob-
lem.  As in the example, our card was not shown in the rectangle, but it is
still functionning.

Click the “Advanced Setup” tab.  This is where some configuration will be
completed.

This window is the same for all capture cards BUT the options available
are different according to each capture card.

You must select your card with the drop-down arrow in the field
“Capture”.  (If your card is not listed, it is because the WDM drivers are
not installed for the card you are using.  Please refer to information
from the manufacturer.)

You must also select the “Input/Output”, the “Video Properties” and the
“Capture Properties”.  These will vary according to each different cap-
ture cards.

The middle part, “Connections”, depends also on your capture card.
Most of the card nowadays will use the “Normal (Default)” setting.  The
“Video Window Size” option should be on “Variable (Default)”.

The “DV Options” section is for experts only.  This is already configured
and the choices should be set to “Enable DV Support” and “Normal”.  The “Bob” options serves no purpose
since it relates only to the “Use Interlace Filter” option.
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5.2.3 Device setup and Video Properties (continued)

The “Expert Setup” tab is where you will be able to actually
see if your configuration works and fine tune it with the
options.

The first step like in the “Advanced Setup” is to choose your
camera using the dropdown arrow at the end of the
“Capture” field.

Once done many settings should appear by themselves and
you might even see a live video in the square window to the
right.

Choices are different according to each individual camera so
we cannot describe them all in here.

NOTICE on top the live image square (showing CADI logo), a
rectangle with text saying “No Button detected”.  This
means that the camera doesn’t have a recognizable button to
capture.  There are different ways to modify/verify that with
each camera individually.

Another common option with the newer cameras is the “Video
Format Compatibility”.  For the camera we were using this
option was necessary.

The tab “Misc” contains the most common buttons used by manufacturer.  If
none of these works there is also a “Shortcut keys” tab in the “WDM Video
StillCap” that you can try to configure a button.

You should always remove the check mark from the “Wait 1 second after captur-
ing” option so that once you have pushed the capture button the live image
comes back immediately.  If you leave the check mark on, it will take an addi-
tional second for the image to come back.

Next is the tab called “Other Camera’s”.  This is for very specific cam-
era so we will not spend anytime on this tab.

If the need to configure something in here comes, you can always call
the CADI Technical Support line to get assistance.
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5.2.3 Device setup and Video Properties (continued)

On the last page when looking at the “Misc” tab, we mentionned that there was a shortcut keys in the WDM
Video Still Cap setup.  If you get out of the acquisition window and back to CADI main screen, you can then
go to “Options” and “” and navigate on the left to the button “WdmStilCap”, you will see that it has three
(3) tabs, click on the one called “Hotkeys”

On the left you can read what the action applied will be.  Each one of these
actions can be applied to a different button on the camera, depending of the
manufacturer of course.

To activate one of these, select the rectangle on the right of the action you want
the button to do, highlight what is there and then push the button on your cam-
era.  The number should change.  If nothing happens, you camera cannot be con-
figured that way.  You might want to review the other buttons settings or use a
foot pedal.

When clicking “Options” and then clicking “Video Properties”, a screen
appears to adjust the video properties of the camera.

The window will look different for each capture card and with some mod-
els there is no more control over the Amplification of Process, so no more
changing the brightness or contrast.  This is mainly on the newer camera
because they are already calibrated to the best of their capacities and/or
you can control the live video feed from the software supplied by them.

One of the tabs is the “Video Proc Amp”.

On this tab, you can adjust your camera settings with a live image on the
screen.

You can adjust “Brightness”, “Contrast”, “Hue” and “Saturation”.  You
can adjust these settings and see the changes as you use the sliders.

Once you’ve found the appropriate settings, click “Apply” for changes to be taken in consideration.

You are now ready to use the intra-oral camera.  Familiarize yourself with the different options available
to fully enjoy the benefits of CADI.
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5.3   Using the WDM Streaming Video in CADI

5.3.1 Setting WDM Streaming Video Options

Within CADI, click on “Options” and then “Setup”.  Once in the Setup window, click on the “WDM
Streaming Video” button to access the options for that module.

(Image reduced for space purpose)

“Desktop File”: Select one that corresponds to your screen
resolution in Windows.

“Grab as grayscale”: This option grabs the movie in grayscale
(black and white) format.

“Fullscreen mode”: To see the live video in full screen.  Full
screen will be the size that your video card is  already con-
figured for.

“Enhanced Quality”:  This option should be checked for live
video to be shown higher quality.

“Check for DirectX x.x”: This option allows CADI to verify if
your system contains the needed version of the Microsoft
DirectX application used for the WDM drivers.

“Preview after capture”: This option starts the preview of the streaming video that you’ve just taken right
after clicking the stop button.

“Use this module for playing video”: This option will allow you to play any video imported in CADI through
the WDM Streaming module.

The “Foot pedal” tab is the same as for the “WDM Still
Capture” module.

“Foot Pedal Connection Type”: To specify the connection
of the foot pedal.

“Game Port”: This setting has no other configuration to it.

“Serial Port”: If using the serial port, configuration must
be done  in the  “Serial Port Settings” section.

“Serial Port Settings”: This section is only used if the foot
pedal is connected to a serial port (COM).  If it is, refer to
the manufacturer’s instructions to configure the COM port.
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5.3.2 The WDM Streaming Video Window and Main Menu

Clicking on the “WDM Streaming Video” icon in the icon pad of CADI will bring you to its module.  This mod-
ule is mainly to capture live videos.

(Image reduced for space purpose)

The “WDM Streaming Video” module window looks like this one.

1: Main Menu of the module.

2: Live video window.

3: Trackbar for the video.

4: Control buttons for the video.

5: “FullScreen” button to view the video full
screen.

6: “Exit” button to exit the module.

7: Speed bar to control the speed of the playback.

8: This viewport will show you the image you cap-
ture while a playback occurs.

9: “Grab” button that lets you capture still images
while previewing a previously recorded video.

10: “Image Library” of the patient.  It is also where your video will be saved.

11: This is only an information bar letting you know the status of the video equipment.

We will now take a look at the main menu to see all the available options.

The first item in the menu is “File”, which contains only one choice; “Exit”.  It exits the WDM
Streaming Video module, not CADI.

The “Options” menu item contains three (3) options.  “Video Properties...”, “Playback
Speed...” and “Device setup”.

“Playback speed...” only brings the playback cursor which is already on the screen if you’ve
chosen the speed bar option.  If not, it will appear so that you can control the speed of the
playback.
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5.3.2 The WDM Streaming Video Window and Main Menu (continued)

When clicking “Options” then “Video Properties”, there are two (2) tabs with options that can be
adjusted to preferences of the user.

The first tab allows changing settings in the “Video Decoder”.  In this one,
be sure that the setting is configured for “NTSC_M” or any “NTSC” setting.

If “Video Standard” is set to “PAL”, the european format, sharing video will
be impossible.

There are a few different standars but the one that we use in North America
is the “NTSC” standard.

The other tab with important features is “Video Proc Amp”.

Within this screen, settings of the video image like “Brightness”,
“Contrast”, “Hue” and “Saturation” can be adjusted.

The best way to adjust these settings is while the camera is live so
you can see the changes as you apply them.  To do so, go to
“Options”, then “Video Properties”, then go to this tab and pick up
the camera.  You will be able to adjust settings and see the changes
on screen instantly.  If the window is in the way, click on the color bar
with the left mouse button and while holding it down, drag the win-
dow somewhere else on your screen.

These options should be left unchanged once selected because they
are related to the hardware part of the camera, not the software.

Clicking on “Options” then “Device setup”, gives access to the configuration of the video card.
This is similar to the “WDM Still Cap” module, so it may already be configured when you access
this window.

There is an important part in the “Device setup” the user MUST configure every time live video is
recorded.

On the next page we will review what is on the “Device setup” window and show the important part of that
window.

NOTE: Since this is video recording and processing, CADI technical support team does not support these
functionalities.  They are personal preferences and cannot be configured by a technician over the phone.
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5.3.2 The WDM Streaming Video Window and Main Menu (continued)

This is the “Device Setup” window.

You can bypass the “Quick Setup” tab and go directly to the
“Advanced Setup” tab.

In “Advanced Setup” tab, under “Video” tab, the “Device”
section should already be filled since it is using the same as
the “WDM Still Cap” configuration.

Your “Device” should be already listed in there; this is your
capture card.  If it is not, use the drop down arrow to select
it within the list.

Verify that the options are correct in “Select input/output”,
“Video properties...” and “Capture Properties...”.  Once
again, these should already be configured if you’ve done the
“WDM Still Cap” configuration.

The “Connections” section has a few options that must be
reviewed;

- “Normal”: This setting is usually the default one for most cameras.

- “Combined”: This setting might be used for some cameras.

- “Use Still Pin if available”: This option is for intra-oral cameras only and should not be checked.

- “Disable Preview while capturing”: This option disables the preview while capturing.  CADI will not dis-
play on-screen what the camera is capturing.

- “Preview after capture”: This option displays what is being captured as soon as you’re done.

- “Quick capture when previewing”: This option allows capture of still images while previewing the video.
This allows to have still shots of some of the live video feed.  You can use the “Pause” button while pre-
viewing to capture with the “Grab” button or you can simply click on the button while the video is running.

The “Compressor” section is VERY important because it determines the compression
method that CADI will use for video live feeds.  There are many compression meth-
ods on the market, so they will not be described here.  Refer to your camera manu-
facturer for such specifications.  We recommend using a commonly used compressor:
MJPEG Compressor”.

As for the “Compressor Options...”, these are specific to each compression method, so we will not discuss
these in this manual.  For details on video compression, consult Microsoft’s website accordingly to your
Windows version or ask your computer administrator.
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5.3.2 The WDM Streaming Video Window and Main Menu (continued)

The “Edit” menu item contains only the “Optimize” option.  Within this menu you
will always see the filter by default for the module and a “No Optimize” option.
Even if you have configured CADI to apply a filter automatically, if you choose “No
Optimize” in this menu, it will cancel the optimization and thus display and grab the
original image from the camera directly.

The “Desktop” menu item contains the usual desktop options and “Visible
Controls” that you can add or remove from the desktop.  Usually, all the options
are selected by default, but since you can customize the desktops to your pref-
erence, these can be added or removed by the click of the mouse.

“Image Library”: displays the image library of the actual patient.
“Trackbar”: displays the track bar for the actual movie.
“Speed Bar”: displays the speed bar to control the speed of the movie playback.
“FullScreen”: maximizes the viewing screen.

5.3.3 Using the WDM Streaming Video Module

Click the “WDM Streaming Video” icon to access the module.

Once in the module, the video will not start recording until the record
button is clicked on the naviguation bar of the Video module.

These buttons work like on a VHS tape recorder/player.

The “Record” button is the RED CIRCLE button.  Recording will not start
until this button is clicked.

The “Stop” is the square button and will stop recording when clicked.

The other available buttons are mainly used while watching the result-
ing video or one recorded earlier.

Notice the Bar with the cursor between the viewing part of the window
and the buttons bar.  This is the “Trackbar”, it shows you where you are
in the video according to its size and length.  You can use the cursor to
move forward or backward or you can use the left/right arrow buttons
on the button bar.

The last button in the bar is the “Repeat” button.  If activated, the video will play in a loop, meaning it
will restart everytime it reaches the end.  This option is for the playback only.

These two (2) buttons are to select a portion of the video to play.  The one on the left will determine the
start of the section you want to see and the one on the right will determine the end of the section.  When
your selection is done, a blue bar will show your selection on the “Trackbar”.
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Picture Directory Import & Export
6.1   Importing a Picture Directory

6.1.1 Configuration of the Import Picture Directory

The “Import Picture Directory” is used in many cases in CADI.  One of the main uses is with digital cam-
eras.  You can import the pictures taken from a patient to his/her file directly from the camera memory.
There are multiple uses to the “Import Picture Directory”, let’s review the options.

Select “Options”, using the left mouse button, then click on “Setup”.  Once in the setup screen, scroll
the list on the left side, locate and click on the “DirImport” button with the left mouse button.  You
will get a screen like the one below:

“Desktop file”: Select a desktop file that corresponds to your screen res-
olution.  Default setting is 1024 x 768.

“Default Source”: Select the source and directory that corresponds to the
images of your digital camera.

“List View”: Choose “Compact” or “Expanded”

“Image View”: Choose “Thumbnails” or “Detail”  
(Example of these four (4) options on the next page.)

“Remove original after import”: This option is to remove the original
images from the camera after import.

“Filter (separate words with ;)”: You can use a filter to import only spe-
cific files.  Separate each word in your filter with a “;”.

“Limit maximum dimensions of color images”: Advanced option to control the size of the color images.

“Auto-rotate”: This option will automatically rotate the images.

The tab “WIA” works only with camera compatible with Windows WIA.

“WIA Version”: This is to choose the version of the WIA.

“Default camera download folder”: This option allows to determine
what folder to use when downloading images from a camera.

“Autostart camera download”: If the camera is permanently connected,
this option will automatically start the importing from the camera when
entering the module.  Advanced users only.

“Remove images from camera after download”: This option will do what
it says if it is checked.

“Overwrite existing images in download folder”: If always using the same folder you can check this option,
it will overwrite old imported files left in the folder.  If not sure DO NOT CHECK.
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6.1.1 Configuration of the Import Picture Directory (continued)

This is the “Import Picture Directory” window with the
options “Compact” and “Thumbnails”.

There are 3 columns of information for this setting.
This is why it is called “Compact”.

On the right side of the window, images appear in
“Thumbnails”.

This is the “Import Picture Directory” window
using the  “Expanded” and “Thumbnails” options.

There are 7 columns of information for this setting.
This is why it is called “Expanded”.

On the right side of the window, images appear in
“Thumbnails”.

This is the “Import Picture Directory” window with the
“Compact” and “Detail” options.

There are 3 columns of information for this setting.
This is why it is called “Compact”.

On the right side of the window, you can see one big
image at a time in “Detail”.

This is the “Import Picture Directory” window with the
“Expanded” and “Detail” options.

There are 7 columns of information for this setting.  This
is why it is called “Expanded”.

On the right side of the window, you can see one big
image at a time in “Detail”.
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6.1.2 Desktop of the Import Picture Directory

Locate the “Import Picture Directory” icon and left click on it. (You can also click on “File” then “Import
Picture Directory”.)

This is the “Import Picture Directory” window.  Here is a description of the main parts of this window.

1: This is the main menu.

2: This is the drop down arrow to choose the drive
from which to import.

3: This is to naviguate through the directory
arborescence to find what you are importing.

4: This is the panel where you can see all the
information available for each picture in the
selected folder(see previous page).  This has two
(2) possible views: “Compact” and “Expanded”.

5: Area where you can display a preview of the
image to import.  This area has two (2) possible
views: “Thumbnails” and “Detail”.  Clicking an
image in this area highlights its corresponding
name in the information area.

6: These are the operation buttons.  You can
“Select All Files”, “Deselect All Files”, “Invert
Selection”, “Import”, and “Import And Exit”.

7: This is the Status Mount area.  Make sure you select the desired mount before importing.  All imported
images will go in the Status Mount in the order indicated by the big gray numbers in the boxes.  The import-
ed images will also go in the Image Library.  You can sort/move them after exiting the module.

8: This is the “Exit” button.  This will allow you to exit the importing module.

Let’s explore the main menu of the “Import Picture Directory” window.

“File formats to import”: Specify here which format of images you want
CADI to import. (By default all formats should be selected.)

“Remove original after import”: This option allows CADI to delete the
images from the source after importing them. (Be sure before activating this
option.)

“Default destination folder...”: This allows the user to choose a different
folder to save the imported images instead of using the actual patient
folder.  Use with extra care.

“Ask for keywords when importing”: This option will query the user to
enter “keywords” for every image imported.  This is practical for later
reporting or analysis.
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6.1.2 Desktop of the Import Picture Directory (continued)

If files are selected in the information panel, two (2) more options in the “File” menu will become avail-
able.

“Import selected images as 24-Bit color”: Select this option to import images in a
high color definition mode.  This is especially recommended for color images.

“Import selected images as 12/16-Bit grayscale”: Select this option to import
images in a grayscale mode.  This is highly recommended when importing x-ray
images.  This option MUST be selected when importing x-ray images in CADI in
order to be able to modify them.

“Exit”: Click that choice to exit the “Import Picture Directory” module, not CADI.

On the left are the available image formats that CADI will import.  Any and all of these formats are recog-
nized by most popular imaging software.  The most common ones you will encounter are “JPG,JPEG” and
“TIF”.  “BMP” format will be needed when importing patients pictures to insert in CADI Data. Note that the
“DIC” format (DICOM) used by CADI is the official format for X-ray images.

The “Desktop” menu contains many options.

The view section, “Compact view” and “Expanded view”, are the manual version of the con-
figuration explained earlier in this chapter.  Even if a selection is made earlier in the config-
uration, you can change it by using this menu.

The same applies to the “Thumbnails” and “Detail” options.

The “desktop” section is the same as with every other CADI module, please refer to the
index.

The “Display skipped thumbnails” will reload the thumbnails in the preview window on the
right.  If you’ve pressed “ESC” while it was loading the thumbnails, they will be resampled
by clicking on that item.

The “fit current desktop to screen” will make the current desktop fit the screen size.

In the “Visible Controls” section you can choose to add some controls to the desktop.  If you
elect to do so, do not forget to un-“Lock desktop” by clicking it. Once modification done lock

it back and save desktop.

Every  one  of  these  controls  can be added or removed from the “Import Picture Directory” desk-
top.  By default, all controls are selected.

“Mountview”: This is to show/hide the “Status Mount”.

“Button “Import””: This is to show/hide the “Import” button.

“Button “Import And Exit””: This is to show/hide the “Import and Exit” button.

“Log”: This is to show/hide the LOG file on the screen.
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6.1.2 Desktop of the Import Picture Directory (continued)

You must have noticed that one choice was not mentionned, the last one: “Position/size con-
trols”.  We will now look at this option.

When clicking on this option many things happen to your CADI desktop.  The main things are that
all windows now have dots in them (grid) and there is a new window that appears.

On the left you can see that all parts of
the desktop have their own grid com-
posed of dots of equal distance.

Usually this tool should be used when cre-
ating a new desktop.  In the example we
are on an existing desktop so the compo-
nents are already sized and positioned, no
need to do anything.

There is also a window to assist you in
your positioning.

We will look at that little window closer.

The four (4) big arrows on top are to
move that window to the top, bottom,
left or right side of the desktop.  You can
also click on the empty space between
the arrows, holding down the left mouse

button, and move the window to where you want it.

The two (2) icons with magnet on them are to “Snap to grid” and “Align to grid”.  These options
will do as they say when components of the desktop are chosen.

The other icons are to assist you in the alignment of the different component.  You can use these
tools or move the components yourself.  You need to have two components chosen, using the
shift key on the keyboard, in order to be able to use the icon tools.  You can “Align left edges”,
“Align right edges”, “Align top edges”, “Align bottom edges”, “Set same size”, “Components
next to eachother”, and “Components on top of eachother”.

Once your changes are done you can use the “Save desktop” or the “Save desktop as ...” (which
is preferable).

After saving you can click the “Exit” button to close that window.  It will also close the edition mode for
that desktop.  You should see the desktop as you saved it.
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6.1.3 How to use the Import Picture Directory

When using the “Import Picture Directory”, the user must know the basics in order to successfully import
the necessary images in the right format.

The information panel will show the content of the directory listed in the top left rectangle.  The first step
is to naviguate to the right place where images are stored to be imported.  (Note that this can be from a
digital camera, an external disk, or a memory stick.)

1 - Click the drop down arrow and
select the right disk drive.  You
have access to all the drives
available in Windows.

2 - Double click every directory
until you get to the one contain-
ing the pictures to be imported.

3 - Click in the “OK ?” column
next to each image you want to
import, the line will become yel-
low with green text.  You can also
pick your images by double click-
ing on them in the preview win-
dow on the right.  Alternatively,

you can also use the “Select All Files” button to select all the available images.

4 - Notice that the “Import” and “Import And Exit” buttons become available as soon as you select your
first image to be imported.

By default, CADI is always set to import in high quality 24-Bit format.  This is perfect for the color images,
but when importing x-ray images you must complete an additional step prior to clicking on the “Import” or
“Import And Exit” buttons.

When importing x-ray images, you must go to the main menu and click on “File”
and then choose the option “Import selected images as 12/16-Bit grayscale”.

This option will import x-ray images as grayscale images, which means they will
keep their gray values thus allowing modification to be done on the image.

If you import an x-ray image in 24-Bit, you will not be able to apply some of the
tools that are built for those types of images.

In such a case, you could re-import the same image but selecting the “Import selected images as 12/16-Bit
grayscale” option.
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6.2   Exporting a Picture Directory

6.2.1 Configuration of the Export Picture Directory

The “Export Picture Directory” has many uses in CADI.  One of the main uses is e-mailing or sending images
to another practician.  There are multiple uses to the “Export Picture Directory”, let’s review the options.

Select “Options”, using the left mouse button, click on “Setup”.  Once in the setup screen, scroll the
list on the left side, locate and click the button “DirExport” with the left mouse button.  You will get
a screen like the one below:

Let’s review the different options of this window.

“Desktop file”: Select a desktop file that corre-
sponds to your screen resolution.  The default set-
ting is 1024 x 768.

“Action when destination file exists”: This  deter-
mines the action CADI will take if the image you are
exporting has the same file name as another file on
disk.

“Exported filename format” this is how the filename
will be encoded.  The most common choice is
“<yyyy-mm-dd> <patient> <description> <ext>”.

“Export File Type”: This is a personal choice.  All
types are good, it only depends on what you want to
do with the exported images.  If you intend to email
you have to choose “JPEG YUV 4:2:2” and make sure
the quality is no higher than 4 bars before “lo”, oth-
erwise people will not be able to view the images
you send.

“Default Destination”: Folder where exported images will be saved.  To modify this location,  click on the
three (3) dots button at the end of the field and choose the destination folder.

“Render annotations”: If this option is selected, images with annotations on them will keep the annota-
tions on the exported image.  If not checked, exported images will have no annotations on them even if
the original does.

“Draw annotations in color on grayscale images”: This allows the annotations to appear in their created
color even if the image is a grayscale.

“Add “Export Picture Directory” entry to “File” menu”: This is on by default and should always be on or
this choice will not be available in the “File” menu.

Always remember to click on “Save Changes” or your selections will not be applied.
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6.2.2 Desktop of the Export Picture Directory

From CADI main screen, click with the left mouse button on the menu item “File”and then click the choice
“Export Picture Directory”.)

This is the “Export Picture Directory” window.

1: The main menu.

2: The “Image library” contains
the images of the actual patient
in CADI.

3: The preview area.

4: Buttons to assist in selecting
images.

5: The exporting panel displays
the images you choose to
export.

6: The “Export File Type”
allows you to  select the type
for the images to export.
Default is “TIFF no compres-
sion” because  images are not
compressed. For sending images
by email, choose “JPEG YUV
4:2:2” to get a smaller file.

7: The information panel for the
chosen picture(s) to export.
Information about the images to
export is available in that

panel.  Using the “Estimate” button will show the exported size of the image accordingly to your choice of
“Export File Type”.

8: Folder where the images will be exported.  To modify this location, click on the three (3) dots button at
the end of the field and naviguate to the destination folder.  (Note that you can export to an external disk,
network drive, or memory stick.)

9: The “Estimate” button.  Choosing an image and a file type, then clicking on “Estimate” will bring an
estimation of the file size once imported.  (See the two (2) fields: “Source size” and “Destination size” in
the information panel.)

10: The “Export” button is used when ready to export the selected image(s).

11: The “e-mail” button is used to email image(s) to an internet recipient.  (Windows must be already con-
figured to use a default email software in order for this to work.  The “Send” button of the email software
must be clicked in order for the message to go out.)

12: The “Exit” button used to exit the module, not CADI.

13: The green bar states the amount of disk space left on the “Destination folder”.
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6.2.2 Desktop of the Export Picture Directory (continued)

The “Export Picture Directory” menu contains three (3) options:  “File”, “Options” and “Desktop”.   The
“File” menu contains only the “Exit” option, to exit the module.

The “Options” menu has five (5) options.

“Skip when destination file exists”:  If the destination filename already exists,
the image will not be exported.

“Overwrite when destination file exists”: Overwrites the existing file when
selected.

“Prompt”: Asks each time how to proceed if the filename exists.

“Render annotations on exported image”: Includes the annotations added to an image during export.

“Render image information on bottom of image”:  Prints image information at the bottom of the image.
This option is very important when sending the images to someone else, if not checked, the images will
contain no information pertaining to what, who and when it was taken.

The “Desktop” menu contains the same options as all CADIs’ module.

The “Visible controls” option contains “Image Viewport” as a con-
trol.  This is activated by default.  To remove it, click on the option,
the check mark will disappear and remove the viewport.

The other option is “Log” and will display the log window on top of
everything.

The differences of the “Export File Type”

The following screenshots show examples of “Destination size”,
after clicking the “Estimate” button for different file types.

File Type: “JPEG YUV 4:4:4 Lossless”

Look at “Source size” and “Destination size”.

The difference in the file size with this compression method is
minor.

Take a look at the “Overall compression” field to know the com-
pression applied to the image.  In this case, a mere “1%” com-
pression was applied, which means the exported image is very
similar to the original.
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6.2.2 Desktop of the Export Picture Directory (continued)

File Type: “JPEG YUV 4:2:2”

Look at “Source size” and “Destination size”.

The difference in the file size with this compression method is bigger.

Take a look at the “Overall compression” field.  In this case “98%”
compression was applied, which means the exported image will be
very compressed and of lower quality.  This file type is best when
exporting images to email.

File Type: “TIFF no compression”

Look at “Source size” and “Destination size”.

The difference in the file size with this compression method is huge.

Take a look at the “Overall compression” field.  In this case “43%”
compression was applied, which means the exported image will be
smaller in size than the original.  The “TIFF” format contains infor-
mation of the picture itself and can be modified more easily.  That’s
why the size is bigger.

File Type: “TIFF lossless JPEG YUV 4:4:4 Lossless”

Look at “Source size” and “Destination size”.

There’s almost no difference in the file size with this compression
method.

Take a look at the “Overall compression” field.  In this case “-2%”
compression was applied, which means the exported image is bigger
than the originalal but smaller in size than a “TIFF” image.
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6.2.2 Desktop of the Export Picture Directory (continued)

File Type: “TIFF lossless JPEG YUV 4:2:2”.

Look at “Source size” and “Destination size”.

There is a big difference in the file size with this compression
method.

Take a look at the “Overall compression” field.  In this case “85%”
compression was applied which means the exported image will be
very compressed and of lower quality.  Another file type to choose
when exporting images to email.  The difference between “TIFF no
compression” and this one, is the format; “TIFF” instead of “JPEG”.

The “File Type” you choose depends greatly on the actions to perform on the exported image(s).  If the file
size is not an object for you, we recommend using the “TIFF no compression” type at all time.  When expe-
riencing size constraints, you can use any compressed type.  Usage of the “Estimate” button will give an
average of the size of the compressed image.  When estimating you can have more than one image in the
window and the estimation of all of them will start automatically when you click the button.  Once done,
you can review each individual image to see the estimated size after exporting.

For emails you must use either “JPEG YUV 4:2:2” or “TIFF lossless JPEG YUV 4:2:2” otherwise the recipi-
ent of the email will not be able to view your image(s).

IMPORTANT NOTE: If using the “JPEG YUV 4:2:2” compression, NEVER put the “Quality” cursor higher than
where it is on the image; fourth (4th) bar before “lo”.  Positionning the cursor too high will create an
unreadable image for Windows.  If you want a high quality “JPEG”, choose the first type availabe; “JPEG
YUV 4:4:4 Lossless”.
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6.2.3 How to use the Export Picture Directory

Using the “Export Picture Directory” to successfully export images in the format you need.

1: Verify the patient number.

2: Double-click an image to see
it bigger in the preview window
(3)

3: The preview window

4: Click on a picture in the
“Image Library” (2) and click
on  the “Add” button to add to
the list of images to export.
You can also use the other but-
tons if needed.

5: List of images you “Add” (4)
shows up in this list.

6: “File Type” choice, in this
example we chose no compres-
sion.

7: “Estimate” button.  Click on
“Estimate” button to get an
estimation of the size after
export.

8: Once “Estimate” (7) is done, look at “Source size” and “Destination size” (8), the estimate of the
exported image size is displayed.  If not to your liking, change the setting in “Export File Type” (6) and
click again on “Estimate” (7).  Repeat this until you get the appropriate file type and size.

9: Choose the “Destination folder” where the images will be exported.  Images can be exported from CADI
Patients folder itself, a Digital Camera, an external disk, or a memory stick.  Click on the three (3) dot but-
ton at the end of the field to bring a “Browse” window where you can naviguate and point to the place
where you want to export the images.

10: The “Export” button starts the export process.  Be sure to have all the settings configured first.  A bar
at the bottom of the information box (8) shows the progress of the exportation process.

11: Click on the “Exit” button to exit the module when the export process is over.  Export is finished when
the bar at bottom of the information panel reaches the end.
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C h a p t e r  7

Scanners and TWAIN Devices

7.1   Configuring your TWAIN Device in CADI

7.1.1 Interface and Options

NOTE: It is important to use a high quality scanner with full-platen (same size as scanner surface) trans-
parency adapter.

Install the scanner and the scanner software as per the manufacturer’s directions.  Ensure that the scan-
ner is connected to the computer and powered on before proceeding.

From the top menu, select “Options” and click “Setup”.

Scroll the list on the left side, locate and click the button “Twain” with the left mouse button.  A screen
like the one below appears:

1 - “Desktop file”: Select a desktop file that
corresponds to your screen resolution.  Default
is 1024 x 768.

2 - “Active Twain Device”: Any scanners or
device that can be accessed through the com-
puter TWAIN service can be selected in this
option.  (Software from the manufacturer must
be installed.)  Select the scanner to use for X-
Ray scanning.

3 - “Transfer Mechanism”: “Memory” is the
default choice.  If scanner does not function
correctly with this setting, select “File”.

4 - “Preset Button1, 2 and 3”: Used to save
configuration in CADI to facilitate scanning of
different types of images.  There are defaults
for Pan, Ceph and GUI (scanner’s Graphic User
Interface).

Click either “Preset Button 1”, “Preset Button 2” , or “Preset Button 3”, to view and/or modify the set-
tings for each preset button.
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7.1.1 Interface and Options (continued)

5 - “Caption”: Type in this field the text you
want to see on the button of CADI TWAIN mod-
ule.  The default captions already in those
fields can be changed to your needs.  Type in
the name you want and click on “Save
Changes”.

6 - “Resolution”: Enter the resolution for the
image to scan.  Higher resolution means higher
quality image but also a bigger image file on
disk.  The drop down arrow menu gives you
options to choose the resolution for the scan.

7 - “Image Type”: Choose between three (3)
types of image.  The first button is for black
and white only; mainly used for text.  The sec-
ond button is for grayscale images; for x-rays
and black and white photos.  The third button
is for color images.  It is important to choose
the right type of image to be sure the scanner
applies the right technique when scanning.

8 - “Pixel Depth”: Default is set to “8” for x-rays including Pans and Cephs.  Scanning a color image needs
the setting to be changed to “24”.  The setting “1” is never used, it is for testing purposes.

9 - “Scanning Area” * **: To determine the scanning area.  The scanner needs to know what part of the
flatbed to scan.  Default is “Autodetect”.  You can change the setting to your preference. (See notes.)

10 - “Light Path”: To specify the kind of scan; x-ray (“Transmissive”) or a picture (“Reflective”).

11 - “Template Area”:  Insert the proper values (in MM) in the appropriate field.  Applicable only if using
a specific scanning area when using “Template”.  See point “9”.

* Modification to “Scanning area” - “Autodetect”:
By default, when scanning Pans (“Preset Button 1”), CADI prescans the flatbed area, determines the size
of the pan, and performs the scan.  If the size of the pan is known, the scanning area can be set to
“Template”, and the size entered manually into the “Template” settings.  This speeds up the scanning
process but not significantly.

** Modification to “Scanning area” - “Template”:
By default, when scanning Cephs (“Preset Button 2”), CADI automatically scans the area determined in the
settings.  This area can be customized using the “Template” settings.

Once the options are configured, click on “Save Changes” with the left mouse button to ensure that the
settings are saved.

NOTE: At the bottom of the screen, in “Module appearance” section, both options must be checked so that
the icons appear on the iconpad, and in the menu options.
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7.1.1 Interface and Options (continued)

The TWAIN module gives access to a menu bar, like in all modules. 

“File” menu has only the option “Exit”, to exit out of the TWAIN module, not of CADI.

The “Edit” menu contains only the optimization selection if applicable, otherwise there
is only the “Optimize” option with the “No Optimize” sub-menu.

The “Desktop” menu contains the desktop configuration options.

It contains “Visible Controls” option to display different
tools on the desktop.  Check mark indicates the tool is pres-
ent on the desktop.  To add a visible control, click it and it
will appear on the desktop.  Adjustment of size and position
will be needed to correctly fit on the desktop.

“Display image parameters dialog after acquisition”  allows
changes to the parameters of an image prior to saving it in
CADI.  Activation of this option brings a window like the one
below, once the scan is completed.

This window allows to change the “Name” of the image, the
“Date” and time of the capture, and the “Resolution” of the
image (changes can only be made in the configuration for this
field).  The name can also be changed when you are back in
CADI and click on save.

The “Magnification factor of acquisition device” is by default
and it is not recommended to modify this option.  Changes
made to this option will distort the image and make all meas-
urements wrong and erratic.

If the defaults settings are always the same, you can uncheck
the option “Display this dialog after each acquisition” and it
will stop appearing and simply apply the defaults settings to
each scan.

Any changes made to an image parameter will not be applied
if “Apply Changes” is not clicked.

Clicking on “Keep defaults” cancels any changes made and
brings the image as-is from the scanner software to CADI
TWAIN module.
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7.2   Scanning Pan, Ceph, Intra-Oral X-Rays and Photo Images in CADI

7.2.1 Use of the Twain Module

Click on the triangle at the end of the mount name with the left mouse button and
select the “pan ceph” mount for storage of the pans and cephs.

Select the “TWAIN” icon from the icon pad.

(Pictures have been cut for space purpose)

To scan a Pan:

Click on the panoramic box (horizontal), (“1”), in the “pan ceph”
mount using the left mouse button.

With the left mouse button, click the “ Pan” button.  The scanning
process starts.  When the process is over, CADI stays in the same
module.  

If  there are  no  more scans  to  perform,  click  on “Exit” using
the left mouse button.                                                                                                                                                                      

When prompted, select “Yes” to save the pan.

To scan a Ceph:

Click on the Cephalometric box (Vertical), (“2”), in the “pan ceph”
mount using the left mouse button.

With your left mouse button, click the 
“Ceph”  button.    The scanning process starts.  When  the process
is over, CADI will stay in the same module.

If  there are  no  more scans  to  perform,  click  on “Exit” using
the left mouse button.                                                                                                                                                                      

When prompted, select “Yes” to save the ceph.
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Scanning Intra-Oral X-Rays and Photo Images

NOTE: These are not pre-configured in CADI, you have to refer to your Scanner User Guide in order to learn
how to use the software that came with the Scanner.  The following are simple steps to do in CADI to scan
these types of image.

For the Intra-Oral images and the Photo Images, select the appropriate mount in CADI to store the images
and click on the third (3rd) button, which should have the name of the scanner or the word “GUI” on it.

This opens the scanner software, and from there use the Scanner’s User Guide in order to get some help
on how to proceed for scanning.  Once the scan is done, CADI will return in the TWAIN module.

If there are no more images to scan, click on the “Exit” button with the left mouse button and answer “Yes”
to save the images.

The samething applies for the Intra-Oral X-Rays.  Be sure to use the “Transmissive” option in the software,
and the best DPI setting for those X-Rays is 600DPI.
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C h a p t e r  8

Reporter
8.1   The Reporter Module of CADI

8.1.1 Configuration of the Reporter Module

Some options must be configured before using the Reporter module of CADI.  From CADI’s main menu,
click  “Options” then “Setup” (or “F10” on the keyboard).

In the “Modules” bar on the left, click the “Reporter Module” button.

(Picture has been cut for space purpose)
This is the “Reporter” module configuration screen.  It contains
seven (7) options. (The last option “Receive Data” is not used.)

“Template Location”:  The folder where the report templates
are to be saved.  This can be on any drive, in any directory.

“Auto Text Location”:  Choices are “Local” or “Same as above”.
This is to set where the auto text you create will be save.

“Email Subject Prefix”:  The text inserted in this option will be
automatically written at the beginning of the “Subject” field of
the email.

“Email Body Text”:  The text inserted in this option will be auto-
matically written in the “Body” of the email.  Advanced users
only.

“Picture Quality”:  To adjust the quality of the picture within the report.  The default is “100%” so that
the images keep their sharpness and details.

“Page view mode”:  To specifty the view when you access the module.  The default is “Normal”.

“Display Annotations”:  When checked, annotations on the images will be atuomatically displayed.

Once all the options are configured, click on “Save Changes” with the left mouse button to ensure that the
settings are saved.

NOTE: at the bottom of the screen, in the section “Module appearance”, there must be a check mark in
both options for the icons to appear on the iconpad, and in the menu options.

These are the only options available for the Reporter module.  Every other option can be controlled with-
in the Reporter module.  These are only general options for the module,  everything configured here can
be modified within the module itself.
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8.1.2 Menus and Buttons

Click the “Reporter” icon to access the module. (The icon with the red halo means there are saved reports
in that patient’s file.

(Picture has been cut for space purpose)

This is a sreenshot of the reporter
module desktop.

1 - The menu bar contains all the
options available for this module.

2 - The buttons bar, contains tools
to use with the report.

3 - The report panel is where you
actually design/use the reports.

4 - The report templates area to
load or save reports.

5 - The field to name the reports.
Type the name of the report in this
field before saving.

6 - The “Template” buttons are
used to save and load the report
templates.

The following pages describes the menu bar and their options.

The “File” menu contains these options:

“New”:  To create a new report;
“Load”:  To load an existing report;
“Save”:  To save modifications to an existing report;
“Save As ...”: To save a newly created report, or an existing report that has been modified;
“Save As Template”:  To save a new/old report as a template;
“Import ...”:  To immport a previously created report;
“Export as PDF ...”:  To export a report as a PDF document readable by Adobe Acrobat Reader;
“Export to Image Library”:  To export a report in the current patient library;
“Page Setup”:  To configure the margins and page configuration before creating a new report;
“Preview”:  To preview the report on-screen before printing;
“Print”:  To print to the default printer without any choices;
“Print ...”: To print using the printer dialog box so you can choose more options;
“Mail To”:  To send an email using Windows default mail client;
“Exit”: To exit the module, not CADI.
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8.1.2 Menus and Buttons (continued)

The “Edit” menu contains these options:

“Redo”:  To redo the last action;

“Undo”:  To undo the last action;

“Cut”:  To cut a selection and place it in Windows clipboard for future paste;

“Copy”:  To copy a selection and place it in Windows clipboard for future paste;

“Paste”:  To paste the content of Windows Clipboard gathered from the “cut/copy” option;

“Delete”:  To delete a selected object on the report;

“Select”:  To select a specific object on the report;

“Find”:  To search for a specific word or expression in the report;

“Replace”:  To replace a word, or words, in the report.

The “Delete” option contains three (3) choices:

“Paragraph Format”: To delete all formats applied to the selected paragraph;
“Character Format”: To delete all formats applied to the selected character;
“Del”: (Future Option.)

The “Select” option contains two (2) choices:

“Select All”: To select everything on the report;
“Table”: To select a table on the report.

The “View” menu contains a few options:

“Normal”: makes the report take all the available space on the screen;

“Page Layout”: shows the report in a page layout, allows to see the margins of the report;

“Zoom”: zooms the report to the percentage chosen in the dop down arrow list;

* “Manage Header and Footer”: brings up a window to manage header and footer of the report,
if applicable;

“Show Field Content”: displays the content of the fields in the report.  If not activated only the
filed names will be displayed;

“Special Characters”: displays all the special characters in the report like the “end-of-line” and
the tabs.

* The next page explains the “Manage Header and Footer” window and its options.

www.cadi.net US: 1-888-582-8115



C h a p t e r  8 : Reporter

98

8.1.2 Menus and Buttons (continued)

The “Manage Header and Footer” window contains buttons to help you manage the
headers and footers.

“Add Header”: Adds a header to a report;
“Add Footer”: Adds a footer to a report;
“Options”: To access the footer and header options;
“Goto Body”: Brings the crusor back on the report while leaving this window open;
“Close”: Closes the “Manage Header and Footer” window.

The two (2) buttons on top are to display the report in the background in full with
header and footer space, or in full text.

The “Add Header” and “Add Footer” buttons bring a menu with options.

Choose if you want the header or footer to be displayed on “All Pages”, “Odd Pages”, “Even Pages”,
“First Page only”, “Last Page only”, “not on first or last page”, or “not on last page”.

These are self-explanatory so no lenghty description is given.  Just be aware that the choice is always
changeable.

The “Options” button brings a menu with options.  These options affect the text of the selected
header/footer.  You can “Delete” a header/footer, “Load Text” into it, “Save Text” from it, “Copy
Text” from it, and “Replace With Copied Text” from another header/footer.

Experiment with these options to familiarize yourself with them.

As headers/footers are being created, they add themselves in the “Manage Header and Footer”
window.  If you choose a header/footer in the list, right click on it, a menu with the same options
as the “Options” button appears.  You can change the options of an existing header/footer.

The “Insert” menu contains many options since it is used to insert objects in the report.

“Page Break” inserts a page break in the report, meaning a blank page is inserted where the cursor is.

“Section Break” inserts a section break; like inserting a page but applied to the section itself.

“External Image” brings a window to insert an external image in the report.  It can be locted on your
hard disk, on the network or any other accessible media.  The formats: “BMP”, “WMF”, “JPG”, “GIF”
and “PNG” are accepted by CADI.

“Image” brings the Image Library of the selected patient.
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8.1.2 Menus and Buttons (continued)

“Symbol” opens the “Symbol” window from which you can choose many different symbols to insert in
the report.

“Numbers” offers you to insert the “PageNumbers”, “Number of Next Page”, “Number of Previous
Page”, or to insert a “Page count”.  These can be inserted in header/footer, or on any page.

“Fields” offers more choices.  If using CADI Data, access to all of CADI Data’s fields is available.  When
using a practice Management (i.e. PowerPractice, Dentrix, etc.) you have access to the field that the
bridge is sending to CADI.

“Bookmark” offers you to insert a bookmark in the report to easily naviguate when the report is longer
than one page.

“Hyperlink” allows you to insert a URL (internet address), or a bookmark previously created.
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8.1.2 Menus and Buttons (continued)

The “Format” menu is an important part of the reporter menu.

It allows to format all the objects in the reports including “Fonts”, “Paragraphs”, “Borders”,
“TabStops”, and “Numbers”.

Each of those options brings a window similar to Microsoft Word’s format window.  Within that window
you can format all of the objects mentionned.

The “Graphic Options” option allows you to specify the position of the image in its frame and relative-
ly to the paragraph.

The “Graphic Options” submenu offers these choices:

“as character” means the image is treated as a regular character, it follows
the flow of regular text, from left to right.
“rel. to par - auto wrap left or right” means the text moves to the left or
right of the image, following the position of the image box.

“rel. to par - wrap left and right” means the image box can be positioned in
the middle of a text and the text will automatically wrap itself around the
box on the left and the right side of it.

“rel. to page - no wrapping” means the image box will position itself on the page.  It will cover any text
in the way.

“rel. to page - wrap left and right” means the image box will position itself on the page but wrapping the
text on the left and right of itself.

Experiment with those options in order to familiarize yourself with them.

The “Capitalisation” choice offers to change the selected text to all lowercase or all uppercase.

The “Extras” menu offers one (1) choice; “AutoText”.  This function will automaticaly change the keyword
you type in a report to the real word.  You have to configure it first of course.  This can save time when
typing long reports or detailed ones with long repeating expressions. 

The “Table” menu offers many options to manage tables.  Tables are a practical way to display informa-
tion in an orderly manner.

The “Table” options works like the ones in Microsoft Office products with a few differences.

Let us review the options.
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8.1.2 Menus and Buttons (continued)

The first choice in this menu is “Create Table” which brings a new window to choose the general proper-
ties for the table to be created.

“Number Of Columns”: use the up and down arrow to specify how many
columns  in the table.

“Number Of Rows”: use the up and down arrow to specify how many rows in
the table.

“Alignment”: use the drop down arrow to choose the alignment of the objects
in the table.

“Border”: use the drop down arrow to choose if you want to see the borders
or not.

“Width”: use the up and down arrow to specify what percentage of the page
width the table will occupy.

All these options can be modified later on using the “Format” menu options.  Once the options are config-
ured in this window, click on the “OK” button and the table appears in the report where the cursor was.

Once a table is created, you can use the other options in the menu to manage parts of the
table.

The “Insert” options offers to “Insert Row” and/or “Insert Column”.

You must select the row or column before using this function.  The row will always be insert-
ed UNDER the selected one and the column will always be inserted to the RIGHT of the select-
ed one.

The “Delete” options offers to “Delete Row” and/or “Delete Column”.

You must select the row or column to delete prior to using this function.

The “Select” option offers to “Select Table” (to select the whole table), to “Select Row”
and/or to “Select Column”.

You can use these options to make a selection prior to inserting or deleting a row or a col-
umn.

Within the “Table” menu, there is the “Split Cell” and “Split Table” options.  Select a cell
or table before using these two options.

The “Split Cell” splits a selected cell in two.  Selecting multiple rows of cells splits all of those by two indi-
vidually.

The “Split Table” splits the selected rows and creates a second table with it.
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8.1.2 Menus and Buttons (continued)

(Image has been modified for space and description purposes)
This image is a reproduction of the icon bar in the “Reporter” module.

1 - To apply certain styles to a paragraph
or document.

2 - To choose a font for a chosen charac-
ter, phrase, paragraph or page.

3 - To choose a font size for a chosen
character, phrase, paragraph or page.

4 - To choose the color of the font for a chosen character, phrase, paragraph or page.
5 - To choose the color of the background for the selected text.
6 - To choose the color of the background for the whole line where the cursor is located.

7 - The usual “Bold”, “Italic”, and “Underline” options.

8 - These are the special options for text; “Superscript”, “Subscript” and “Strike Out”.

9 - The paragraph alignments.  They are: “Left Align”, “Center”, “Justify”, and “Right Align”.

10 - These two (2) icons are the “Bullets” and “Numbering” options.

11 - These two (2) icons are the “Left Indent” and the “Right Indent”.  Used to move paragraphs to the
left or right by controllable increments.

12 - The first icon is the “Table” icon, same as using the “Table” menu except that you must select the
number of columns and rows using the mouse.  Drag the cursor, holding down the left mouse button, over
the quantity of columns and rows you want and release the mouse button.  The second icon is the “Borders”
icon.  Brings up a window to choose what side of the cell you want to apply borders to.

13 - The “Status Mount” icon brings the Status Mount window on the left of the report so that images can
be drag and dropped in the report from the patient’s status.

14 - The “Image Library” icon brings the Image Library window of the patient so images can be drag and
dropped in the report.

15 - The “Print” icon.  Prints immediately, no other window will appear.

16 - The “Email” icon. Opens a new message in Windows default mail client.

17 - The “New” icon.  Does the same as “File”, “New” menu.

18 - The “Load” icon.  Does the same as “File”, “Load” menu.
19 - The “Save” icon.  Does the same as “File”, “Save” menu.
20 - The “Exit” icon.  Does the same as “File”, “Exit” menu.
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8.1.3 The Reporter Desktop

The report area where you can design the report allows to add text, text box, images, automatic field and
more.

The main areas are:

1 - The Report area where you type
and insert the components desired
in the report.

2 - The existing templates list.
Choose a template for the report.
You can add to this list by creating
your own.

3 - This is where you type a name
for a newly created template.

4 - Click on this button to create a
new template.

5 - This button closes the template
area and displays the report full
screen.

6 - This button allows to alternate
between the saved documents and

the templates.  You can go back and forth between those two just by clicking the button.  The text on the
button changes accordingly to what window is displayed.

7 - This option can be activated or deactivated as you please.  Choosing a template in the list and putting
a check mark in this option will load that template each time you open the “Reporter” module.

Back to point “6”, when clicking on the “Switch to saved documents” button, the list and
the text on the button will change.

The list will show the documents saved up to now, empty on first access, and allow to load
one of these documents.

You can create a new document from here by clicking the “New” button.

Note that you can go back to the template window, the button now shows “Switch to tem-
plates” which will bring back the template window.

Experiment with these 2 different ways of reporting prior to creating usable reports.  A
template is used for many different patients, while a document is usually a letter with
patient information that has been saved as a document.
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C h a p t e r  9

Advanced Filtering

9.1   The Optimize Module of CADI

9.1.1 Advanced Filtering of the Optimize Module

With CADI comes the Optimize module that allows you to add extra information, effects, corrections to any
image you desire.

With the newest version comes an option to modify an image already optimized.  You can now click on
CTRL-F when you already have an image in the viewport and that will bring up a new window that allows
you to make modification to an existing filter or create/add/delete items to it.

This window will show you what filters have already been applied to the image if any.
If the tab “Filter Script” is empty then there are no filters on that image.

Unchecking one of those filter will immediately show you in the viewport the effect
it does on the image.  The same applies to the order of the filters.  In CADI, the order
in which you apply the filters will produce differents results.  If the histogram is on
the desktop you will see the slightest change modify the histogram, simply because
some changes are not really viewable with human eyes but will affect the end result.

To change the order of the filters simply choose the one you want to try to move in
the list and use the arrow icons on the left to move up or down in the list.  Like men-
tionned earlier, when changing the order of some filters, you might not see a differ-
ence, it is because the action done by that particular filter is invisible to the human
eye, it will only show up on the histogram.

The “X” icon when pressed will delete the filter on the line you have highlighted.  If you hit that icon by
mistake you can always click on CADI’s top menu item “Edit” and choose “Filter Redo”, that will put back
the last deleted line in the filter script.

The square icon and the checked square icon are for disabling and enabling all the filter lines in the script.

The “O” icon will reload the original script file attached to the image on-screen, undoing any/all changes
you made to the script.

The information displayed at the bottom of the window is showing some information about the loaded
image, “I:” is for the intensity, “C:” is for the contrast, and “W:” is for the windowing.  In this example
the two first settings are set at 0 because there were no intensity or contrast change applied to the image.
The same thing with the windowing, when you see “0-255” it means that no windowing has been applied.
If those settings have numbers, it indicates the amount applied to the image, and for the windowing, it
shows the range that was chosen between 0 and 255 (0 being black and 255 being white).
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9.1.1 Advanced Filtering of the Optimize Module (continued)

When you click the hourglass icon you will see the filters window appearing. (This
function is best used when viewing the image with the “Contrast/Intensity combo” and “Windowing”
panels loaded on CADI desktop.)

This panel contains all the available filters in CADI and is a reproduction of the fil-
ters available in the “Optimize” module with some additional advanced filters.

“Flip Vertical”:  This does an horizontal mirror, the top becomes bottom and vice-
versa.

“Flip Horizontal”:  This one mirrors the image verticaly, the left becomes right
and vice-versa.

“Rotate”: Allows to rotate both ways by 30 degrees increments.

“Invert”: Inverts the grayscale, black to white and white to black.

“Average” et “Median”:  These 2 are two different methods of blurring the image.

“Sharpen”: This sharpens the image by raising the contrast on pixels.

“Despeckle”: This removes some noise(dust) on the image.

“Gamma”:  To raise or lower the image luminosity.

“Gaussian Blur”: Another method for blurring an image, this is the prefered
method.

“Unsharp Mask”:  This is a way to increase sharpness especially in scanned or dig-
ital images.  The “Radius” affects the size of the edges; smaller radius enhances
smaller details while higher radius can cause halos and soft edges.  This interacts
with the “Fract” settings.  The “Fract” controls the brightness change according
to the disctance between the values.  Low values sharpens more while high val-
ues excludes areas of lower contrast.

“Stretch Intensity”: This will eliminate some grays in order to attempt to equal-
ize the brightness by averaging the brigthess and darkest values in the image.  Can
be used before auto-windowing to have greater results.

“Histo Equalize”:  Similar to stretch intensity but applied without windowing.

“Histo Contrast”: Another way of getting more brightness while not affecting the
grayscale.  The histogram shows you the difference between these methods.

“Histo Stretch”:  This will stretch the histogram values augmenting the contrast.

“Windowing”:  You can manually tweak the histogram with this function.  The left
side of the slider is for the black and the right side for the white.  You can also
move the slider once you’ve changed the position.  This works well with the
“Stretch Intensity”.

“Auto Windowing”: This function includes two (2) settings; “B/W threshold” and
“Counts threshold”.  The first is for elimating empty zones of black and white, the
second one is to determine the threshold of the grayscale.  You can experiment
with this.
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9.1.1 Advanced Filtering of the Optimize Module (continued)

“Spatial Filter”:  This one has many choices to experiment with and is mainly to
give some kind of an embossed look to the image.

“Shadow”:  A filter that sharpens the image and makes it like an emboss but also
keeps the grayscale.

“Reload Image”: Allows you to reload the original image.

“Combined Filter 1”: This is a combined filter for contrast and brightness.  You can
play with the value and find the ones that suits your needs.

“Combined Filter 2”:  Another combined filter but with many more options aplied
simultaneously.  After experimenting and testing you can get the values you found
to apply automatically with one filter by using this one and entering your values in
the appropriate field.  Checked options will be applied and unchecked ones will be
ignored.

“Draw Text”: Option that allows you to insert text into an image with many
options.  You can either use the preset texts or just type in the field “Text :” what
you would like to be printed on the image.  You can apply many options to the text
but in order to be readable always use at least a “Size :” of 14, and most of the
time the “Color :” should be white or black.

“Resample”: You can use this to change the size of the image.  Be sure to use the
right width and height or the image will be distorted.

“Grayscale(16)”:  This filter will change the image into a grayscale image of 16
bits.

“Color (24)”: This will change the image into an image of 24 bits usually for color
images.  This will NOT transform a B/W image into a color one.

“Intensity / Contrast / Windowing”:  If you know the values you want to apply to
these three (3) settings, you can insert them in here and create them as a com-
bined filter.  This is a way to decrease the number of filters applied to an image.

These are the advanced filters offered in CADI.  You might want to experiment
with them before starting to apply any filter to any image.  You can always
restore an image to its original values by using the “Reload Image” icon in CADI’s
icon pad, or click on the “X” icon in the “Filter Script” of the advanced filters
after selecting the line you want to delete.
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Appendix A

Optio Dentistry Patient Education Software

Navigation
When you start a movie, or playlist, you are presented with two navigation options - Step-by-Step or
Auto Run.

1.  Step-By-Step
Using the step-by-step navigation, you are able go through each movie at your desired pace. You can
click forward and backward or replay steps as needed. This gives you the flexibility to emphasize differ-
ent steps to each patient, depending on their specific needs.

2.  Auto Run
You also have the option to simply run the movie(s) that you want the patient to view. Each movie has
a narration that, combined with the movie, covers the information that the patient needs to know to
make a decision regarding treatment.

Playlist
If there are a few movies you want the patient to review, you can create a play list, which will play
those specific movies. Just click on the boxes beside the names of the procedures that you want to
show the patient, and then click "Begin Playlist".

Languages 
You have the option to change the subtitle text to reflect the native language of your patient. To change
the language, click on the language button at the top of the software interface. A small box will appear
showing the languages that are currently available. Select the language you would like to see, and
click "OK". This language will remain in use, until you select a different language.

Print 
The Print section allows you to print one page information sheets for each treatment option. These
printable files are in Adobe .PDF format and require the freely available Adobe Reader to be installed
on your PC. If you do not have the free Adobe Reader softare already installed, you can download it
from Adobe Systems Incorporated (New Window).
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Appendix B

Implant Feature

Implants

The implants feature is a part of CADI to assist professionals to choose the right implant according to the
patients bone structure.  With CADI you can determine what implant to use by inserting the different
brands/models directly on the x-ray of the patient, thus eliminating the need to print the x-ray and put the
implant overlay on top of it to choose the right one.

To access the implant feature, load a x-ray in the active viewport and then click on the icon “Annotations
& Measurements”.  When the window appears, click on the middle tab called “Implants”.

The implants window contains two (2) sections, the brand/model name and the bottom
section showing the different available sizes according to each individual brand/model.

When clicking on a brand/model, the bottom section will change to display the implants
available for that brand/model.

Be aware that NOT all of the implants are listed here.  Some will be added with time
and based on the availability of the manufacturers.

To be able to use the implant feature keep in mind that the image you are using must
be calibrated. (Refer to the appropriate section for the Calibration.)

To insert an implant on the x-ray simply click on a brand/model and then choose the
one you would like in the bottom section, and then click on the “Insert” icon.

To delete an implant, select it on the x-ray and then click on the delete button of your
keyboard.  To delete ALL the implants on the x-ray simply click on the “Delete All” icon
and all the implants on the image will be deleted.

The “Show Info” button is to display the info of the implants on the x-ray image.  It can
be activated after inserting the implant on the image.

The “Hide Info” button is to remove the info of the implants on the x-ray image.  Once removed they can
be displayed again by clicking on the “Show Info” button.
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Appendix C

How to Customize your Desktop

How to Modify the Desktop

One of the advantage of CADI is the ability to modify many of its components and module to suit your need.
In this section we will explore how to modify the desktop in order to facilitate your work.

The first thing you have to get acquainted with is the desktop resolution.  This is how many pixels you are
displaying on your screen.  You might have heard or seen desktop resolutions without knowing what it was
because on every software they mention what screen resolution you should use.

CADI offers many resolutions including the most common ones for widescreen monitors.  This is to allow
you to use the maximum size available for your monitor and thus allowing you to display more panels and
tools on the main screen of CADI.

To find out the resolution your computer is using, you must minimize CADI and be able to see Windows
desktop, this is the background picture with all the Windows icons on it.  Once on Windows desktop, click
the right button of the mouse to make the menu appear and then choose “Personalize” (in Windows 10).

The “Display Settings” window looks similar to the one here, in Windows 10.

If you have multiple monitors you will see more than one rectangle/square in the
“Display settings”.  In this example, CADI is used on monitor “1” so it is the one cho-
sen (highlighted).

The information we are looking for is called “Resolutions”.

Take note of the numbers, in the example 1920 x 1080, this means the resolution of
the screen in the example is 1920 x 1080 pixels and thus the desktop you must load
to benefit the whole size is the 1920 x 1080 in CADI.

This is the number you should use for naming the desktops you create.  On the next
page you will have to give a name to the new desktop you will create, write down
the resolution of your monitor so that you can include it in your filename.  This makes
it easier when loading a desktop in CADI.
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How to Modify the Desktop (continued)

You always need to start from an existing desktop, giving it a new name and then you can start moving the
modules around to your liking.  For the purpose of this explanation, we will start with the single viewport
desktop.

Click and hold down the left mouse button on the icon for the desktops and choose desktop #2;

This will load the double viewport desktop.  Before going any further, lets name our new desktop in order
to be able to save our changes.

To do this, click on the top menu “Display”, then “Desktop Panels” and then click
on “Save desktop as ...”.

You will get a window like this one where you must specify a filename for that desktop.

You should try to give a name that will include the Windows desktop resolution in it.  A good
example of this are the ENDO desktops.  These were made especially for endodontists and have
tools specific to their needs.  You can do the same with YOUR desktops.

Type the name you want in the “Save current desktop as :” field and click on the “OK” button
to save it.  This will add the new desktop to the list and thus will be available the next time
someone foes in CADI.

NOTE: the desktops are saved localy so when you create a desktop it will only show up on the
machine you created it on.  To have the desktop available in all your operatory, copy the desk-
top file from the computer you created it, to the other computers.  The file goes in the same
place for all computers: “C:\CADI\Desktops\”.  The files are always starting with the following
words: “ilCoreNormal” followed by the name you gave it.

You are now ready to start modifying the desktop but before you do so you still have
to UNLOCK it or you will not be able to move or size anything.

Click on “Display”, “Desktop Panels” and click on “Lock desktop”.

When the desktop is unlock there are no checkmark on the left of it.  If there is a
checkmark on the left of “Lock desktop”, click on it to remove the checkmark, thus
unlocking the desktop.
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How to Modify the Desktop (continued)

Another detail you can easily notice is that when the desktop is unlock, there are little bars that appears
in the upper left and bottom right corners.  These are the handles you will be using to move or size the
object on the desktop.  The upper left corner handle is used to move the objects while the bottom right
handle is used to size the objects.  You should experiment with those to get familiar.  When the desktop
is locked, none of these handles will be visible.

Most of CADIs’ module are modifiable, every window that has those handles can be sized and/or moved
to your liking.  The modules you can modify are: the viewports, the icon pad, the status mounts, and all
the panels available in the “Display”, “Desktop Panels” menu list.

Each of these panels can be put on screen and each has its own functions.  The panels that have a
check mark on the left of their name are the ones actually displayed on your desktop.

To add a panel, click on it’s name and it will appear on the desktop.  If the desktop is unlocked you
will be able to size and place the panel where you want it.

To remove a panel, click on it’s name and it will remove itself from the desktop.  You will notice that
the check mark is gone when you do this.

Take note that some panels works together.  As an example, the “Contrast/Intensity” panel and the
“Windowing” panel works together.  On the “Contrast/Intensity” panel you can see an histogram of
the actual image (this is only for x-rays, 16 bits images), it looks like mountain peeks and there are
usually empty space on the left and on the right of those.

Clicking the little “A” button on the right of the “Windowing” panel will eliminate all empty spaces
to make the image sharper and clearer.  To reset it to the original, click on the “double-arrow” but-
ton on the left of the “Windowing” panel.

Like you can see, some of the panels work with other panels in unisson.  When you want to add a panel
just make sure that you know how to use it and that you really need it on the desktop, otherwise leave it
as an option because you can always load a panel at any time during usage without the need to have it per-
manently on the desktop.

Once all the changes you want are made, don’t forget to LOCK the desktop and to save the desktop using
the “Save desktop” command from the top menu “Display”, “Desktop Panels”.
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Appendix D
Usage of the Macros

How to Create a Macro

We will now explore how to configure macros in CADI.  Macros are only usefull to automate some
tasks or to simplify the way to access certain functions of CADI.

For this exercise we will create a macro that will bring us automatically to the desktop #3 while
starting on desktop #1.  At the moment you should still be on the desktop #1 if you’ve just com-
pleted the desktop exercise.

Click on the “Options” item in the top menu and then click on the “Macro’s” choice.

The “Macro’s” window will appear.

The window contains only the “Add”, “Edit”, “Delete”, “Record” and the “Exit” but-
tons.

To record a macro, press on the “Add” button.

The “Add/Edit” window is where you will define the macro, name it and save it.

To create the macro, make sure there is a check mark in the “Activate macro” choice.

Then you should immediately give it a name that describes the action it will perform.
In our case we will call it “Desktop Switching” since the macro will move us from
Desktop #1 to #3 by pushing one key on the keyboard or clicking a button. (To have
both working, simply put a check mark in the “Create button” option on the left.)

Under the “Create button” option you can see arrow-like images and a button under
it called “Add image to list”.  Clicking this button will allow you to load images in BMP
format to identify your button with.  There are 8 (eight) ready-to-use buttons, if
you’ve never created icons we suggest using these.

For this example we will use the default arrow icons that are there already.

Now we must assign a keyboard function key to the macro we are creating.  By default
the “F1” key is always assigned to the HELP function in most software.  It is the case
with CADI so you must choose another function key.

For the purpose of the exercise we will choose “F2” as being the “Hotkey”
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How to Create a Macro (continued)

This is what the screen should look like at the moment.

If you have chosen the right options like described, you can now click on the “Save” button at
the bottom left.

This will close the “Add/Edit” window and bring you back to the “Macro’s” window where we
will record the macro itself.

Once back to this window, it is now time to record the macro.

Click on the “Record” button.

This will bring the “Information” window to remind you how to stop recording your
macro (pressing the “F12” key on your keyboard).

Click on the “OK” button when ready to start recording.

Now click on the desktop icon holding down the left mouse button and choose the desktop #3
from the choices that appears.

Now press and hold the “Ctrl” key on the keyboard and while holding the “Ctrl” key press the “F12”
key.  This will stop the recording of the macro.

The “Macro Done” window should appear letting you know that the macro has been succesfully record-
ed.

Just click on the “OK” button.

On the next page we will test the macro to see the result.

www.cadi.net US: 1-888-582-8115



A P P E N D I X : Appendix D

118

How to Create a Macro (continued)

To test the macro we just did, click on the desktop icon and choose the desktop #1 like where we were
before we started to do the macro.

Once on the desktop #1, try your newly created macro by pressing “F2” on the keyboard or the
“arrow” icon in the icon pad.  Both of those should do the samething since they have the same macro
attached to them.

Once done, you should now be on the desktop #3 like we instructed the macro to do.

You can do macros for many different functions, you simply have to find the steps that you reapeat the
most often and those usually can be put into a macro.  Always try the macro before telling others that they
can use it.

Once your macro has been tested and works correctly, you can make it available for use even if CADI is
not the main window.  Go in “Options” and the “Macro’s”, click on your macro and choose “Edit”

Once in the “Add/Edit” window of the macros, if you look at the section “Hotkey :”, you will
see under the “F9” choice an option called “Systemwide”.

By putting a check mark in this options, the macro you are editing will be available even if CADI
is not the main window on your screen.

Try to avoid using the following “Hotkey :”: “F1” and “F10” because they already have functions assigned
to them in CADI.  The “F1” is assigned to the help files and the “F10” is the function key you can use to
access the “Options”, “Setup” of CADI.  Be sure to test the key you use, some other softwares also uses
function keys, like Adobe Photoshop.

Macros can do more than just change a desktop choice.  It is up to you to find out what set of operations
could be recorded into a macro and then used with a function key.  Just remember that the action you want
to record has to be performed by a software that doesn’t think, so you must be sure that theses actions
can be done at anytime otherwise the macro will not work.
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Appendix E
Building Status Mounts

How to Create your Own Status Mount

The part that most people are using and would like to modify to their needs is the Status Mounts.  These
are the rectangles that allow you to capture images already in the right order.  In this appendix you will
find out how to create your own Status Mount.  (It is not recommended to modify and existing mounts since
it will be brought back to its default every time CADI is updated and thus losing all your modifications.)

Let us create a Status Mount containing three (3) bitewings images on each side of the mouth.  The first
thing to do when creating a Status Mount is to select an existing one that looks like the one you would like
to create.  In this exercise we will be starting from the Status Mount “x-rays primary” and modify it to suit
our needs.

First thing is to unlock the desktop so click on “Display”, “Desktop Panels” and then on “Lock desktop” to
unlock it.  (If there is no check mark on the left of “Lock desktop” it means it is already unlocked.)

Click on the drop down arrow of the field “Mount” and choose the “x-rays primary” mount using the left
mouse button.

(Image has been modified for space purpose.)

This is what you should see.  Notice the handle on the
top left corner, look like 2 horizontal bars, and the
one on the bottom right corner, look like diagonal
lines.

The top left bars are to move the window while the
bottom right one is to size the window.  Usually those
are already on the right format so you should not use
them.

Once the Status Mount is on the screen and the desk-
top is unlocked, it is time to name your new Mount
before going any further.

To do so, click on the drop-down arrow at the top right and choose “New scheme”.  It will bring
a window to give a name to the new Mount.  Type the name “Bitewings L-R” and click on the
check mark icon.  The Mount will now be titled the way you named it.
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How to Create your Own Status Mount (continued)

Like mentionned on the last page, the Mount now has the new name we gave it.

These names are for you to easily identify the content of the mount itself.  You
can use descriptive names in order to facilitate the identification of the mounts.

The rectangular box on the top left contains thirty-two (32) little squares in it.  Each
of those squares represent a status box.  They start on the top left of this window and
end at the bottom right.  This means that at the moment there are ten (10) of those
squares that are “green”.  Each square that is “green” represents a box on the mount.

For the purpose of this exercise, we need to remove four (4)
squares from the mount because we only want to have three
(3) images of bitewings on the left and the same on the right
for a total of six (6) boxes.

Click on the last “green” square, you will see that the box
number “10” will dissapear from the Mount.  Repeat this
operation for the three (3) other squares (boxes “9”, “8”
and “7”).  Once done, the Mount should look like this pic-
ture.

This is the time that you will now move the actual boxes to the position you would like them.  If you click
on one of those box, it will become a darker grey and if you hold the mouse on top of it, you will notice
the two little bar (handle) in the top left corner, they are the same as the one on top of the Status Mount
window and serves the same purpose; to move the box to the desired location.

For this exercise move the three (3) boxes of the left closer
to the center and do the same for the one on the right.  We
suggest that you move the box “1” and “2” closer to the cen-
ter first and leave only a small space between the two boxes.

Now move the box “3” near the center, a little off from the
box “1”.  Also move box “5” near the center and a little off
from box “2”.  You might notice that the window move by
itself a little bit while you were doing this, it is normal, it is
always automatically recentering itself.

Lastly, move box “6” near the center aligning it with box
“3”.  As soon as you release the mouse button from box “6”,

you will see the whole window redraw itself, it is normal.  Now move box “4” near the center, aligning it
with box “5”.  When releasing the mouse button, the whole mount should recenter itself automatically.

This is it for the positioning of the boxes in the mount.  You should have a similar mount to the one dis-
played here.
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How to Create your Own Status Mount (continued)

Now that you have created the boxes for the Status Mount you want, we can change the numbering of
the tooth and the orientation of the boxes individually.  This allows you to specify if the box should
display the image in a portrait orientation (like the picture of a face) or landscape orientation (like a
picture of a landscape, used especially for bitewings).

To do this, click on the drop-down arrow at the top right and choose “Image associations” from the
menu.

You will see a new window called “Image Association”.  Within this window you can apply
many different options to each individual box.

To apply any changes to a box you must first click that box so that it becomes dark gray.
Once chosen, the “Image Association” window will show you the “Orientation” of the box,
the associated tooth numbering, and the orientation of the digital sensor.

These information are when you are using the “Teeth Chart” tab of the “Image Association”
window which corresponds to using the mount for xray images.

If you intend to use the mount for intra-oral camera images you will use the “Standard cor-
rections” tab which has different options.  We will get back to this one later.

For the moment, click on box “1” of your mount.  If you followed the exercise you should
see the orientation set to “Landscape”, the numbering “55-83” and the orientation of the
sensor should be on the lower right choice like on the image. (The chosen orientation has
a green dot on the icon.)

For the purpose of this exercise we will change the tooth numbering and the orientation  of
the sensor.  None of these are accurate, they are only for the practice.

Now click on the teeth chart the six (6) teeth that will highlight the range “18-46”.

Then click the bottom left sensor to select it.

The square in the middle of your “Image Association” window should display the same as
the image on the left.  The tooth numbering should be “18-46” and the chosen sensor ori-
entation should be the bottom left one, it should now have the green dot on it.

To record these changes for that box, you always need to click on the box once the changes
are made.  If you don’t click it, all your changes will be lost and the box goes back to the
default settings.

You have to do this for each individual box that you want to create and/or edit in a mount.
For this exercise we will not do other boxes.  When done, click the top right corner “X” to
close the “Image Association” window.
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How to Create your Own Status Mount (continued)

Once the boxes are identifed and have the right orientation, you can also create your own sequence
for taking the xrays.  The sequence is representd by the big number in the middle of each box.
Usually the order is already set during the creation of the mount but if you need to change it or cre-
ate multiple ones, we will explore this option.

In order to create a new sequence you need to click on the arrow at the end of
the “Status Mount” window and choose “Toolbars” and then “Sequence
Selector”.

You will get a new little window added to the “Status Mount” window.  It
always goes to the “Default sequence” because it is the one written in the
actual boxes of the mount.  Like mentionned before, those should be pre-
determined during the creation of the mount and this is why the default
sequence appears first.

To create your own sequence you have to click on the arrow under the “green circle” and choose
“Add/record a sequence”.

When you click on “Add/record a sequence”, a “New sequence” window will appear.  Type the name
you would like to call your sequence.  For this exercise type in “test cadi” and then click the check
mark button at the end.

An “Information” window will appear.  This window is simply indicat-
ing the procedures to follow to register a sequence.

In resume it says that you have to click the boxes in the order you want
the sequence to go and when finish you press “ESC” on the keyboard
to stop the recording.

To start recording the sequence, click on “OK”
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How to Create your Own Status Mount (continued)

The cursor will change to a “01”.  Click the first box of the status.  The cursor will now
become a “02”, click the second box of the status.  The number will change each time
you click a box, this number is the actual sequence number.

Click on each box to make a sequence like the one on the example.  This is only an exer-
cise and this has no influences on your default templates and sequences.

When done, press “ESC” on the keyboard like mentionned in the “Information” window.
You can also right click in a box to stop the recording.

You will get a confirmation window letting you know that the sequence has been
recorded and saved successfully.

Click on the “OK”

You should now lock the desktop again, “Display”, “Desktop Panels” and “Lock desktop”.

Don’t forget to save your changes to be sure that all you’ve done is recorded and saved within the
status mount.

To do this, click on the drop down arrow at the end of the mount window and choose “Save
changes”.  This will save everything you’ve done.  

If you click on the arrow under the “green circle”, you will notice that your sequence is now a
part of the list.

Be aware that when you create a new sequence it will not automatically come up, you have to manually
choose the sequence each time you go in the acquisition.  This is by default and cannot be changed.  The
reason being that the status mount always uses the sequence the boxes were configured with thus the
importance of making the righ decision when creating a status mount.
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Appendix F
Display Settings In-Depth

Exploring the Options of CADI Display

CADI is offering many options for searching and categorizing the images, to customize some of the func-
tions of CADI and to also configure your display the way you want.  To do this you have to go in CADI and
click on the “Options”, “Setup” and then click on the tab “Display Settings”.  If you followed the instruc-
tions, you should see a screen like this one.

In the “Misc settings” section you can select on
what monitor to display CADI. This is, of course,
available only if you have more than one (1) mon-
itor connected to the computer. (CADI works like
programmation so monitor zero (0) is actually monitor 1
in Windows.)

The option “Nr of “Recent Accessed Patients” to
keep” is to determine how many patient CADI will
keep in memory for rapid access.

The option “Display histogram in C/B combobox”
allows the histogram to be displayed in hte
Contrast/Brightness box for each image shown.
This is helpful for exposure analysis.

The “Fade effect” option has been introduced
mainly for the AERO GLASS function of Windows
Vista.  You can turn it on or off without affecting
your work in CADI.  For fast access you should turn
this option off.

In the “Sub-desktop custom names” section, you can click in each individual sub-desktop name and change
it to a more descriptive heading.

To change a name simply left-click in any of those field and type the name you would
like to appear.

These changes will be seen when you put your mouse over the corresponding icon in
the icon pad.  It is only simpler to identify than just having number one (1) to five
(5) listed.  This way you can really give a name that corresponds to your need.
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Exploring the Options of CADI Display (continued)

The next section is the “Image Properties Settings” which is itself split into two (2) sections, the “Extra
Info” and the “Image Keyword List”.  Let’s first view the “Extra Info” section.

In the “Extra Info” section, you can configure some of the options that will be available when saving the
images after acquisition.

To configure one of those options you have to click on the
icon at the end of the field.  This will open the correspon-
ding document and allow you to enter the text you want.
Each options you want to enter has to be on an individual
line in the file.

The “Info Field File” is for the comments you would like to
add to images.
The “User Field File” is to identify the user that took the
image.
The “Grade Field File” is to grade the images.
The “Type Field File” is to identify more easily the type of
image this is.

EXAMPLES:

If you click on the icon at the end of the “Info Field File”, Windows Notepad will
open a file called “comments.txt”.  This is where you will enter the desired com-
ment choices.

In the example I simply wrote what you see so you can notice what it does when
exiting the acquisition screen.  Just remember; one comment per line only.

When exiting the x-ray module you will have the opportunity
to save a comment with the image that has been pre-written
in the file “comments.txt”.

The advantage of this is the ability to identify the images in an
exactly similar pattern instead of being written manually, thus
avoiding typing errors/mispelling.

Now take a look at the next image, it will show you the “Specify Extra Info &
Keywords” window that appears when you put a check mark in that option.  It
allows you to immediately capture extra information for that image using an
easy drop-down list.  The choices available in the drop-down list is determined
by you.  These are the files that we will explore next. 
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Exploring the Options of CADI Display (continued)

Going back to the “Image Properties Settings” options and in the “Extra Info”
section.

The “User Field File”, “Grade Field File”, and “Type Field File” options are
where you can configure those extra information we just saw on the “Save”
window of the acquisition screen.

All of these open their corresponding file, (path and name are displayed in the
appropriate field), in Windows Notepad which allows you to configure the
options that will be available in the drop-down list on the “Save” window.

The tab “Image Keyword List” allows you to add “Keywords” to a pre-estab-
lished list.  These are also saved in a separate file identified in the field:
“Keywords File”

There are three (3) keywords already entered since they are the most common-
ly used one.  When you click on the “Add” button, it adds an empty line to the

list, you just have to type in the keyword you want to add to the available list.  The “Search
& Add” button is to search in your keyword folder for all available keywords.  This option is
used in very large clinic or in educational institution.  Within this option you can also create
folders to sort your different keywords.

The keywords will be available during the saving part of the acquisition.  If you put a check
mark in the choice “Ask for keywords after acquisition” in the “Image Keyword List” config-

uration window, The extra information window will automatically appear during the saving part.  If you
don’t put the check mark, when saving images in the acquisition module, you will have to click on the
option “Specify Extra Info & Keywords” on the save window to be able to input information on the images. 

The “Image Library Settings” tab has a few options that can be configured.

“Display logo in image Library” will display CADI logo in the Image Library window.

“Monitor / Auto refresh Image Library” should always be chosen
(checked).  It allows other CADI users to see the images as they are saved
in the patient’s library.

“Show tiny teeth chart” displays a small teeth chart in the Image Library
that shows you in an instant what tooth have images in the library.

“Activate the global folder by default in the Image Library” If this
option is checked, when accessing a patient, you will see the “Global
Library” instead of the patients’ library.

“Label display mode” is used to choose what information will be shown under the images.  The usual choice
is “Date original Image”

“Global folder” is the location of the “Global Library” on the hard disk.  It should be left to the default
setting.
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Exploring the Options of CADI Display (continued)

The “Default folders” tab shows the default folder that is created by CADI
when it creates a new patient.  By default, CADI only adds the folder
“Video” to the patients’ folder.  You can remove or add other folders to
that list by typing a semi-colon (;) at the end of the word “Video” and add
the name of the folder you would like directly after the semi-colon.  You
can create as many folders as you would like.  Note that you can also cre-
ate those folders within the “Image Library”.

“Create these folders on existing records” is an option to consider before
applying.  The new patient will have those folders automaticaly created
but checking this option will create them for the patient already existing.

There is no automatic method to delete those folders once they are created, be sure to consider that fact
before applying this option.

“Ask for confirmation before creating these folders” is an option to make sure that you want the folders
to be created before doing so.  If checked, CADI will ask you before creating the folders on a new patient.

The “%DATE(YYYYMMDD)” option will create a folder in the format shown between the parentheses.  As an
example, you would see in the “Image Library” a folder called “Video” and another called “20100325”.

The tab “Patient folder presets” is for future usage only and is not functional at the moment.

Now we go to the “Status Settings” tab.

The “Automatically switch to the scheme used in the acquisition module” will
change the status on screen to the one used in the acquisition module.

“Display status subfolder dialog” turns on or off the status folder dialog.

“Background color” The “Default” is the regular charcoal color.  If you choose
“Custom”, you have to click on the rectangle on the right to choose the color
you want.

“Enable right-click “delete from disk”” This option is to consider very carefuly.
CADI now protects you by HIDING the images instead of really deleting them.  This allows you to restore
images deleted by mistakes.  If you check this option, everybody will be able to delete an image complete-
ly.  We strongly recommend leaving this option unchecked.
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Exploring the Options of CADI Display (continued)

Now we go to the “Viewport Settings” tab.

The “Grid” section allows you to activate a grid.  Put a
check mark in the choice “Draw calibrated grid on view-
port” and then simply choose the size, the style and the
color you desire.  After you click on “Save Changes” and
“Exit”, you will see the grid you’ve just defined on the
viewports.

The “Ruler” section has a similar function but displays a
ruler in the corners that you specify with the “Ruler posi-
tion” option.  Of course you can also choose the “Ruler
color”.

“Viewport info footer” allows to see the name and date of
the image at the bottom of each viewport.

“Sec full screen after acquisition” you can put a number (in seconds) to display the acquired image in full
screen.

The “Viewport display quality” should always be configured to “High”.  We always want to see the images
in the highest quality possible.

The “InfoBar Image Date Notation” allows you to specify the date displayed in the information bar in the
middle of the screen.  Either choose the “Original Image” or the “Modified Image” date.

The “Active Viewport background color” can be changed.  The “Default” is the regular gray color.  If you
choose “Custom”, you have to click on the rectangle on the right to choose the color you want.

“Viewports auto advance” checking this option will advance to the next viewport each time you load an
image into an empty one.
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Appendix G
Miscellaneous Settings and Maintenance

Review of the Options for the Miscellaneous Settings & Maintenance Tab

When you are looking at the “Setup” window, one of the the tab is called “Misc setting & Maintenance”.
We will now explore the options in that tab.

The first option available is “Send the configura-
tion & log file, and ask for support (e-mail)”.  It
should not be activated since it is faster to call
the support by phone than wait for email.

Then you have the option “Open the log file in
the default text editor”.  this option is also self-
explanatory, it opens the log file in the default
text editor of MS Windows.  The log file is usualy
for technicians and thus not usefull for the users.

The third option is to “Open the user configura-
tion file in the default text editor (experts
only)”.  Once again, this is an option for the tech-
nicians and should not be used.

Now we get to an important option of this win-
dow, the “Open the patients folder in Windows
Explorer”.  This option can be used for many pur-
poses.  You can use this to find out if the patient

you are looking at has any images not shown in the “Image Library” because it will open a window to that
patient’s folder.  The most practical part of this option it to verify where the patients’ data is being saved.
Expecially when you are using a bridge with a practice management, this option becomes very practical
since it is the only way to find out where CADI is saving the images.

Under those buttons, there is a section called “CPU”.  It will list how many CPU it finds in the PC.  It also
has an option that should be checked already called: “Force Single CPU”.  It should always be activated to
make sure that the computer uses only one CPU for CADI thus leaving some processing resource for the
other hardware and applications.

The section “VDDS-media interface” is for a practice management in Europe and is not available here.

The “PMS Interface Tweaks” is to tweak the behavior of the practice management software.  “Emulate the
BeginTransaction...” option should be used with older practice mangement software only.  The “Display the
patient information dialog...” should ALWAYS be checked to be sure to enter the missing patient informa-
tion when available.

130www.cadi.net US: 1-888-582-8115



A P P E N D I X : Appendix H

A P P E N D I X  H

Appendix H

The Calibration Table

How to Use the Calibration Table

In CADI, under the menu “Options”, there is an item called “Calibration Table” that has been described
briefly in “Chapter 1” and in “Chapter 2”.  We will now go more in-depth in the explanation of how to
use that calibration table with your hardware.

The calibration table is used to add some measurements that are not already part of
CADI.  Most hardware manufacturers are covered by CADI’s calibration table but
sometimes, some hardware is not calibrated and must be in order for you to have
appropriate measurements.

When you first calibrate an image, it is applied to that image only.  In order to have
all the future images already calibrated and ready to use for measurements, you
must learn to use the “Calibration Table”

The window is called “Calibration Table [ ]”.  The number between the square
brackets indicates the number of entries you have in the table.  Each measure
needs a “Width”, a “Height” and a “Pixels/Meter”in order to work.

Once you have calibrated an image, take note of the elements that we need in order
to enter them in the table.  You need to take note of the width, the height and the
pixels/meter of the calibrated image.  Once ready, you can now click on the “Options”
menu and choose “Calibration Table”.

Click on the “Add” button in the calibration table window.  A line will be added to the
end of the table and the cursor will already be in the field “Width”.  Enter the width of
the image then click in the “Height” column and enter the value, and finaly, enter the
value that you noted for the “Pixels/Meter”.  Once done click on the “Save” button and a
confirmation window will appear.  In order for the calibrated image to work on portrait or
landscape orientation, you must add the same values again on a new line but inverting the
width and the height.  By doing this, whatever orientation the images come in, they will
always be calibrated.
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Appendix I

Radiological Log

Configuration and Usage of the Radiological Log module

Before you can use the Radiological Log module of CADI you must configure it.  In CADI, click on
“Options”then “Setup” and click on the module Radiological Log in the list on the left.

The only thing you must change is the “Max. nr of results”.  You must set
this to “99999” because the default is not enough.

Click on “Save Changes” and then “Exit”.

To access to this module you must click on “File” from the top menu and then “Radiological Log” which-
will bring you into a new window for that module.

The top menu “File”
and “Desktop” do not-
contain any options
besides the different
sizes of desktops and
the “Exit” command.

We will now explore
this window more in-
depth on the next
page to familiarize
with the options and
the result screens that
contains many column
with information that-
might be useful.
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Configuration and Usage of the Radiological Log module (continued)

01 - Here you specify what report
you want, for the current patient
loaded in CADI, for “All patients”
or for a “Specified (PatientID)”
patient.  When choosing specified
patient, you must supply the num-
ber for that patient.

02 - This is the place to specify
the date range you are looking
for.  You can specify a range by
clicking the calendar icon of
“Start date:” and “End date:” or
you can choose an already made
query by clicking one of the
“Presets:”.

03 - You can leave this option on
“All computers” to let CADI
search the whole network or you

can choose a “Selected computer:” by clicking the drop down arrow and choosing the computer to look on
for the actual query.  The icon at the beginning of this field will try to resolve the name of the PCs for you,
it takes more time and some might not be found.

04 - You can also specify for what practitioner you would like to query.  If not important for the query, leave
the choice on the default “All practitioners”.

05 - When the options are configure to search for what you are looking for, you can click on the “Update”
button.  It will take some time but you will see the results of your search in the empty space on the right,
where the number “07” appears in the example (the number of results found will also be indicated at the-
bottom of the screen where you see a zero (0) at the moment).

06 - That small icon allows you to save the result as a text file in the CSV(Coma Separated Value) format.
The advantage of this format is that you can open it in Microsoft Excel and manage the columns and lines-
like an Excel document.

07 - This is where the results will be displayed.  The results will supply you with: the date the image wastak-
en, the patient number, the patients name, the exposure (in EU only), the equipment used, the type ofthe
equipment and the grade (if used).  Each line has a plus sign (+) that gives you access to more information
like the practitioner, the user, the image filename and the computer IP address.  While you might not use
all of this information it still might be usefull to troubleshoot some imaging problems over the network.
When exporting to CSV format and opening into Microsoft Excel, you can remove the columns you don’t
need.  If you just want to know the total amount of images, just look at the bottom of the screen for a lit-
tle number; that is the total of images for that search.

This should assist you in finding out how many images you take per week, month, year, patient, room,
oreven per doctor.
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Appendix J

Image Library Tools

Configuration and Usage of the Image Library Tools

Before using the Image Library Tools you should activate one of the options
described earlier in this manual and located in the “General Settings” of CADI in
the “File handling” section.  As an extra protectiion against accidental deletion,
we’ve added an option to CADI called “Hide image(s) instead of delete”.  It actu-
aly does what it says, when you delete an image it hides it from the library view
but keeps it until you purge or restore it with the Image Library Tools.  This will
be practical in case of erroneous deletion of images.

To configure the “Image Library Tools” you need to verify the options and configure them before they
can be used.  In CADI, click on “Options” then “Setup” and click on the module “ImageLib Tools” in the
list on the left.

On that screen there are only two (2) options: “Dump file list to tmp folder” and  “Filter
patients with zero imagecount”.

The option “Dump file list to tmp folder” will create a text file containing the list of ALL
the images in the Patients folder, and put it in the TMP folder of CADI for you to consult.
The same results will be shown in the Image Library Tools in an orderly fashion.

The other option: “Filter patients with zero imagecount” should be checked in order to
make the search faster and avoiding seeing patient numbers with no images associated
with them.

Now that the options are configured you can go into the Image Library Tools module by clicking on “File”and
then “ImageLib Tools”.

As soon as the module comes up you will get a small windows ask-
ing you to wait while the results are generated.

On that small window you already can see some information about
you patients folder like the amount of folders, this should corre-
spond to the amount of patients you have for your practice, of
course this number includes every patients, even the ones that

you’ve rendered inactive in your practice management.  If you never deleted the actual folder of the
patient, it is still in the patients folder of the server, thus it is calculated in the results.
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Configuration and Usage of the Image Library Tools (continued)

When the count is finished, you will get a screen of results similar to the one below. (Image size was
reduced and names were hidden for privacy purposes.)

Here are some basic function of this interface to assist you in visualizing the results.

- The available columns are: “ID”(patient number), “Patient Name”, “Date”(showing the newest image
date), “#Images”(Qty. of images in the folder, parenteses for qty. of hidden images), “#Folders” (Qty. of
subfolders, parenteses for qty. of hidden subfolders), “#Status” (Qty. of Status Mount with images in  them),
and “Size” (Amount of space taken on the disk by these images).

- If you click on any column name on top, the list will be sorted by that choice, clicking again reverses the
sort order.

- When you double-click on a patient’s number, its own library will be displayed in the Image Library.  This
allows you to view multiple patient’s files in the same interface.

- If a new image is taken while you are in this module it will automatically refresh itself, or you can also
use the “Refresh” button to do so.

- Right clicking anywhere on the screen will bring a popup menu that will be described later.

- There is also a “Filter” option, on top left of the “Refresh” button, that allows you to filter out the results
according to specific criterias, which we will review later.

- The top menu also has some options you can activate or deactivate; we will also review those later.
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Configuration and Usage of the Image Library Tools (continued)

The menu item “Desktop” offers you a few options, some of them are also in other places in the software
and if activated, there will be a check mark on that option already.

“Visible Controls” offers only a log viewer on the screen that is not usefull except when having
problems.

“Refresh” is to refresh the results on screen.  Be aware that the patients folder will be rescaned
to find any changes made to them.

“Filter patients with zero imagecount” will not include the patient without images in the
count.(This option is also in the configuration of CADI, in “File handling”.)

“Refresh selected” will refresh the selected line(s).  It will only rescan the selected patient fold-
er instead of the whole directory.

“Automatic Refresh” is a nice option because it will automatically refresh the view as soon as a change
happens on any directory.  Be aware that when in a live clinic with people working you might want to turn
off this option because every time someone takes an image the refresh will rescan everything and this can
become tiresome.

“Dump file list to tmp folder”  will generate a CSV format file with the information you see on screen and
save it in the “TMP” folder of CADI (C:\CADI\tmp).  (This option is also in the configuration of CADI, in “File
handling”.)

“Verbose Logging” This option will describe a little bit more what has been done in the module and save it
to the log file.  Don’t expect explanations, only textual descriptions instead of just action description.

Another menu of options is available when you right click in the results window.  Let’s review that menu.

“Open/Display” will display the images of the selected line(patient) in the Image
Library.

“Open folder in Explorer” this will open the selected line(patient) folder in Windows
Explorer.

“Select All” will select all lines(patients) in the results window.

“Select All with deleted files/folders” will select lines(patients) in the results window
that contains files or folders deleted(hidden).

“Select Range” allows you to select a range of lines(patients).

“Invert Selection” will simply invert the selection you’ve made.

“Deselect All” will deselect all lines(patients)

“Restore deleted folders and images {filter unaware}” will restore everything that was deleted
(hidden)without applying filters.

“Purge deleted folders and images {filter unaware}” will permanently delete all folders and files previous-
ly deleted(hidden) without applying filters.
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Configuration and Usage of the Image Library Tools (continued)

“Check files for errors” gives you two (2) choices to check, the “Status files” and the
“Images”.  The two (2) should be checked when applying this option, it will verify that all
the data is ok, that there are no errors in the statuses and files for the selected line(s)
(patient(s)).  When ready to proceed, you click on “GO!”

“Export” will simply export the result in a CSV format file.

If you put a check mark in the “Filter” option at the bottom left, it will
open the filters window that allows you to choose amongst many criterias.
Some of those have to be already used by the clinic to work like; “User”,
“Grade”, “Type” and “Keywords”.  The “Date” criteria is usable for any-
clinic since it only looks at the image date.  These filters are the same asde-
scribed earlier in this manual, under the Image Library configuration.

An example of the information displayed by the results window.

First thing to notice is that when there are deleted (hidden) images or folders, the fields “#Images” and
“#Folders” are greyed compare to regular fields, this indicates there are things hidden.

In the example of line(patient) “1011”, “#Images” is showing us “10(6)”.  This means that there are 10
images displayed and 6 hidden(deleted).  The number between parentheses is the number of deleted(hid-
den) images for that patient(line).  The field “#Folders” is showing us “0(1)”,  this means that there areno
subfolders for that patient but there is 1 hidden(deleted).

The second example, line(patient) “1200” , “#Images” is showing us “34(5)”.  This means that there are 34
images displayed and 5 hidden(deleted).  The field “#Folders” is showing us “1(0)” and is not greyed,  this
means that there is 1 subfolder for that patient and none hidden(deleted).

The third example, line(patient) “1201”, “#Images” is showing us “118(0)” and is not greyed.  This means
that there are 118 images displayed and none hidden(deleted).  The field “#Folders” is showing us “0(2)”,
this means that there are no subfolders for that patient but there are 2 hidden(deleted).

With this example you can now see the importance of this new option and tool.  You might think that some
images or folders are deleted when they are actually hidden.  You could now use the “Restore” or “Purge”
option available when you right click in the results window.
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Appendix K

Cadi Data Agenda

Usage of the Cadi Data Agenda

Cadi Data has an agenda to allow the scheduling of patients.  This will not replace the practice manage-
ment software since it can only schedule appointments, nothing else.  If you are not using Cadi Data at allin
your practice then this module is not for you.

In Cadi Data top menu “Options” then
“Preferences”, there is a tab called
“Agenda” that we’ve seen earlier in
this manual.  Go to that tab so you can
follow the explanation for all these
options.

In the first section on top left,
“Agenda”, you can start by setting up
the clinics opening and closing time.
This is configured in the “Displayed
Hours” fields.  You have to manually
type the “Start Hour:” and “End
Hour:”.

The next fields are for the “Working
Hours:”.  This is the place where you
will type the “Start Hour:” and “End
Hour:” for the appointments.  The

hours selected in these fields will be the only one you can use to schedule appointments.  It should be dif-
ferent than the opening and closing time.

You then have the “Appointment duration” field.  You can configure this for the amount of time you want
the schedule to set aside for a due appointment.  If you configure a small amount of time, you can always
select more than one period for an appointment so take this in consideration when typing the duration in
the field “Length in min:”.

The option “Scale to fit” is almost a necessity.  The look of the agenda is much better with this option acti-
vated.  Try it yourself and decide what you prefer.

The option “This Room:” allows you to select if the agenda will display the schedule for this room only or
for all the rooms in the clinic.  This is up to the user to decide since it is a personal preference.
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Usuage of the Cadi Data Agenda (continued)

The section for the “Rooms:” is important because this is where you will configure the amount of room-
sand their name to display.

To add a room to the list you simply click on the “Add” button and a new
entry will be added to the list under the rectangle “Rooms:”.  To remove a
room, select it in that list and click on the button “Remove” and the select-
ed room will be deleted from that list.

To change the name of the rooms, you simply click in the field itself, in the
example: “Room 1”, and replace the actual text with the name you want
for that room.

The “Default Appointments:” can be tailored to your needs.  In this
example, we’ve added a new choice: “Seminar” by typing a name in
the empty field, choosing a color by clicking the color square and then
clicking on “Add / Change” created this new entry.  To modify an exist-
ing one you select it in the list and change the options you want; either
a different color or a different name.  Always click on “Save” after
making modifications or creating new items.

This is it for the configuration of the agenda.  Next we will explore the agenda itself to see how it works.
Click on the calendar icon in Cadi Data to bring the agenda.

A full screen window will open (shrunk here for space purpose) show-
ing you the whole agenda.

Depending on your choices during configuration, you will notice on
top left that the agenda will cover “All Rooms” or the rooms you’ve
configured earlier.  You can always click the drop down arrow and
choose an individual room.

On the right you can see the calendar showing the actual date in the
selected square (colored).

The agenda has a certain color code by default, the actual time peri-
od is always shown in YELLOW.  The BLUE rectangle in the agenda is
the position of the cursor, or the selected rectangle if you prefer.

The GRAY zones on top and bottom and the hours the clinic is open
but no scheduling is possible for those zones.  It is the visual differ-
ence between the two options mentioned earlier; “Displayed Hours”
and “Working Hours:”.  You can modify those at any moment as long
as you don’t overlap an already scheduled zone or period.

Now we will see the agenda usage on the next pages.
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Usage of the Cadi Data Agenda (continued)

The top left has the room selection.  By default, except if you already modified the setting, “All Rooms”
should be displayed.  To choose individual rooms, you click the drop down arrow and the menu showing you
the available rooms is displayed.  Left click on the room you want to schedule.

Remember that when exiting and going back to the agenda, the default chosen in “Preferences” will come
back and be displayed.  When scheduling an individual room, rest assured that when you view all rooms,
the appointments will ALL be displayed in the proper room.

The calendar allows you to schedule different appointments at different dates by clicking on
the desired date.  You can use the arrows and double-arrows to naviguate through the months
and years (single arrows for months, double-arrows for 1 year at a time but same month and
date).

The chosen date is always displayed in the first column of the agenda.  When accessing past
or future dates and you want to come back to this date, simply click the “Today” button under
the calendar.

After a few days of usage, you will start seeing BLUE lines in certain dates.  This indicates
that there were appointments those days.  The same applies for future dates, they will also
display blue lines if there are appointments scheduled for those dates.

For future dates with appointments you might also see another visual aide on the agenda itself
which we will review later.

To schedule an appointment you double-click a rectangle in
the agenda correponding to the date and time you want and
for the room that you want.  A window like this one will
appear.

The “Begin Hour:” and “End Hour:” don’t need any changes,
the “End Hour:” will adjust itself when you choose to modify
the “Duration” of the appointment.

For the “Patient:”, you can click on “Current Patient” or you
can choose a different patient by clicking on “Select
Patient...” to see the list of patients in a new window from
which you can choose the desired patient.

The field “Notes:” can contain special notes concerning the
patient or the procedure.  It will appear in the agenda.

The last field at the bottom is the one where you choose the
visual aide that will show the procedure or appointment
depending how you configure it.  This is when it is important
to decide prior to scheduling what you want to display in the
agenda. It could just be appointment or it could actually men-
tion the procedure with a different color for visual reference,
it is up to the users to decide.
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Usage of the Cadi Data Agenda (continued)

For this example we chose a regular appointment and we’ve inserted the note “Routine Exam”.
Notice on the image the red color for the appointment, each procedure has its own color that you
decide in the “Preferences” of Cadi Data in the tab for the agenda.  The visual aide is practical
and can be a big help to rapidly visualize the kind of procedures for a period of time.  You can also
see the note that’s been typed.  If the note is bigger than the displayed area, simply drag the bot-
tom right corner of that appointment to make the window bigger.

If you double-click an appointment it will take you out of the agenda and back to Cadi Data with
the clicked patient on-screen.  If you want to view or modify the appointment, right-click on it with
the right mouse button and left click on “Edit”.

A longer “Duration” of the appointment will make the rectangle of the appointment bigger.  It will
cover the total amount of time by filling all the needed square to fulfill the request.  In the exam-
ple we have chosen a duration of two hours and fifteen minutes (2:15) thus making the rectangle
cover nine (9) blocks of fifteen (15) minutes each, totalizing the duration of the appointment.

You can always move an appointment within the agenda, in this example we dragged the previous
appointment of fourteen hundred hour (14:00) and moved it to noon (12) in order to have enough
time for the procedure.

At the bottom of each column (day), there is another visual aide,
itindicates the percentage (%) of time used in the available “Working
Hours:” in the agenda.

As an example of the way the agenda can be used, we’ve created this dummy agenda to
give an example of the visual guide that the agenda can be.

First we’ve created the actual appointments names and colors.  You can choose anything
you would like for this part, it is actualy here that everything should be decided prior to
taking any appointments with Cadi Data.

You can see that the color coding might have an advantage for the fast
reviewing of the procedures.

Each color tells you what procedure you have scheduled for that period
of time which allows you to manage your time more adequately.

The last thing to mention is the print feature.  If you click on the “Print”
icon at the bottom right, it will shrink the agenda to fit unto the size of
paper available in your printer and print it.  Nothing will change on your
screen.
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